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Communication Kits 3127850

Installation and program setup instructions for use with ProMix® 2KS Electronic
Proportioners. For professional use only.

Not approved for use in European explosive atmosphere locations.

See page 3 for kit information.

Read all warnings and instructions in this manual
and in your proportioning system manual. Save
these instructions.

@ Important Safety Instructions
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Graco Gateway Kits

Graco Gateway Kits Related Manuals
15V331 Gateway Ethernet Kit Component Manuals in English

Allows communication between ProMix 2KS and a PLC

over an ethernet. Enables process equipment to read Manual Description

variables while operating, as well as control the ProMix 312778 ProMix 2KS Automatic System

2KS and change setup. It does not provide access to job

Installation
and alarm logs. ; :
312779 ProMix 2KS Automatic System
: : Operation
15V963 Gateway DeviceNet Kit

312780 ProMix 2KS Automatic System
Repair-Parts

313386 Basic Web Interface/Advanced Web
Interface

Allows communication between ProMix 2KS and a PLC,
using DeviceNet process control. Enables process
equipment to read variables while operating, as well as
control the ProMix 2KS and change setup. It does not
provide access to job and alarm logs.

15V964 Gateway Profibus Kit

Allows communication between ProMix 2KS and a PLC,
using Profibus process control. Enables process equip-
ment to read variables while operating, as well as con-
trol the ProMix 2KS and change setup. It does not
provide access to job and alarm logs.
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Warnings

Warnings

The following warnings are for the setup, use, grounding, maintenance, and repair of this equipment. The exclama-
tion point symbol alerts you to a general warning and the hazard symbols refer to procedure-specific risks. When
these symbols appear in the body of this manual, refer back to these Warnings. Product-specific hazard symbols and
warnings not covered in this section may appear throughout the body of this manual where applicable.

/\ WARNING

FIRE AND EXPLOSION HAZARD

Flammable fumes, such as solvent and paint fumes, in work area can ignite or explode. To help prevent
fire and explosion:

Use equipment only in well ventilated area.

Eliminate all ignition sources; such as pilot lights, cigarettes, portable electric lamps, and plastic drop
cloths (potential static arc).

Keep work area free of debris, including solvent, rags and gasoline.

Do not plug or unplug power cords, or turn power or light switches on or off when flammable fumes
are present.

Ground all equipment in the work area. See Grounding instructions.

Use only grounded hoses.

Hold gun firmly to side of grounded pail when triggering into pail.

If there is static sparking or you feel a shock, stop operation immediately. Do not use equipment

until you identify and correct the problem.

Keep a working fire extinguisher in the work area.

ELECTRIC SHOCK HAZARD

This equipment must be grounded. Improper grounding, setup, or usage of the system can cause
electric shock.

Turn off and disconnect power at main switch before disconnecting any cables and before servicing
equipment.

Connect only to grounded power source.

All electrical wiring must be done by a qualified electrician and comply with all local codes and
regulations.

EQUIPMENT MISUSE HAZARD
Misuse can cause death or serious injury.

Do not operate the unit when fatigued or under the influence of drugs or alcohol.

Do not exceed the maximum working pressure or temperature rating of the lowest rated system
component. See Technical Data in all equipment manuals.

Use fluids and solvents that are compatible with equipment wetted parts. See Technical Data in all
equipment manuals. Read fluid and solvent manufacturer’s warnings. For complete information
about your material, request MSDS forms from distributor or retailer.

Check equipment daily. Repair or replace worn or damaged parts immediately with genuine manu-
facturer’s replacement parts only.

Do not alter or modify equipment.

Use equipment only for its intended purpose. Call your distributor for information.

Route hoses and cables away from traffic areas, sharp edges, moving parts, and hot surfaces.

Do not kink or over bend hoses or use hoses to pull equipment.

Keep children and animals away from work area.

Comply with all applicable safety regulations.

312785D




Graco Gateway Overview

The Graco Gateway enables the ProMix 2KS to network
with a programmable logic controller (PLC). Kits are
available for Ethernet, DeviceNet, or Profibus protocols.
The Graco Gateway will support many other protocols;
contact Graco Technical Assistance for information to
support your desired protocol.

NOTE: Only persons very familiar with their PLC com-
munication architecture should use this hardware and
software. This manual assumes that the person using
the Graco Gateway has full understanding of the PLC
equipment and related software.

NOTE: Network communications essentially operate
with the same rules as Discrete 1/0. However, network
communications require placing correct values or
adjusting appropriate bits within various Modbus regis-
ters (for example, see Table 4). These changes should
only be made by qualified persons familiar with this type
of communication.

The module allows for most PLCs to communicate with
the ProMix 2KS via Modbus RTU protocol by bridging
the gap between the desired communication protocol
and RS485 Modbus RTU. As a result, the PLC has full
access to all the registers for monitoring and controlling
the ProMix 2KS. It is the responsibility of the integrator
or user to ensure proper configuration of the communi-
cation hardware on the PLC side.

312785D

Graco Gateway Overview

Install the Gateway
Module Hardware

Location

This equipment is not for use in explosive atmo-
spheres. Do not install equipment approved only for
non-hazardous location in a hazardous area.

Install the Gateway module near the EasyKeyTM, ina
non-hazardous area.

Mounting
1. See Dimensions, page 80.

2. Ensure that the wall and mounting hardware are
strong enough to support the weight of the equip-
ment, cables, and stress caused during operation.

3. Using the equipment as a template, mark the
mounting holes on the wall at a convenient height
for the operator and so equipment is easily accessi-
ble for maintenance.

4. Drill mounting holes in the wall. Install anchors as
needed.

5. Bolt equipment securely.

Grounding

NAEN[@

Your system must be grounded. Read Warnings,
page 4.

The Gateway module is grounded through its connec-
tion to the EasyKey, which must be connected to a true
earth ground. See the system installation manual. A
ground wire and clamp, part no. 223547, is available
from Graco.



Install the Gateway Module Hardware

NON-HAZARDOUS AREA

Graco Gateway

Module
USB Cable
(included), for initial
setup only
EasyKey
PLC Communication
Wire/Cable
(protocol dependent) \
2-wire twisted
pair cable, with
shield wire
o | ]| | R —
(=
© B
O
S~ ocoo O B
NN NN NN NN NNNNNNNEEN
Computer (PC) TI13939a
Programmable Logic Controller (PLC)
FIG. 1: Graco Gateway Typical Installation
6 312785D



Connect the Module to the

EasyKey
N[/

FiG. 1 is only a guide showing installation of the Graco
Gateway in a ProMix 2KS System; it is not a complete
system design, Contact your Graco distributor for assis-
tance in designing a system to suit your particular
needs.

1. Shut off ProMix 2KS power (0 position). FIG. 2. Also
shut off power at main circuit breaker.

W

0= OFF

TI12657a

il

Fic. 2: Power O
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Install the Gateway Module Hardware

2. Connect a 2-wire twisted pair cable with shield wire
from the EasyKey connector to the connector on the
Gateway module. Connect a communications
wire/cable (protocol dependent) from the Gateway
module to the PLC. See FIG. 4.

NOTE: Graco provides expansion cards for DeviceNet
and Profibus protocols. DeviceNet setup procedures are
on page 43. Profibus setup procedures are on page 58.
See page 41 for Parts.

NOTE: If using the Graco Gateway in your system, dis-
connect its cable from the EasyKey before updating the
ProMix 2KS software.



Install the Gateway Module Hardware

Power Connections 2. Connect the line (L) and neutral (N) wires from a
100-240V, 45-65 Hz, AC power source to the 24V

power supply as shown.

m‘ w & 3. Use the two lengths of 16 AWG wire (18, provided)

to connect the power supply (4) to the gateway (10),
as shown.

1. Shut off ProMix 2KS power (0 position). FIG. 2. Also
shut off power at main circuit breaker. 4. Connect the desired communication cables (see
Cabling Connections, pages 9-11). After all con-
nections have been made, connect power to the
100-240V AC source.

+24V —

ti12929a

Fic. 3. Power Connections
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Install the Gateway Module Hardware

Cab“ng Connections See FIG. 5 and FIG. 6 for typical cable connections in a
ProMix 2KS system.

A w FiG. 7 through FIiG. 10 show other possible cable con-
nections.

EasyKey (Bottom View)

TI12638a
2-wire twisted pair cable, with
shield wire (to Gateway Module)

Gateway Module

I
il

-
]
=
-

o
o
s

USB Port

u

[0O OO0
0o00| —

[Gl6]0/0]0)

S
|\

=
Ed

el

8

Is

i

H
ﬂ;

= ‘ ‘ TI12930a

Communication Wire/Cable (to PLC). 2-wire twisted pair cable, with
This connection is protocol dependent. shield wire (to EasyKey). See

Wiring Diagrams on page 42
for pin connections.

FiG. 4: EasyKey and Module Cable Connection Points
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Install the Gateway Module Hardware

1 Common
2 24 Vdc +/- 10%
3 N/C

Power Connector

COMM
COMM

Tx .

' RTS Pin6

8CTs Pinl
Rx

RS232/PG
/ A\
)
= <-‘ : — |
USB/PG _ D j_——l
- ® Expansion
& N a cF Port
R <
O Y

TxB
- TxA

COMMS

— ©

£ £

o ss 0O

n =E= n 0
5&38%%k =

e ETHERNET

Green/
| Amber 8
Yellow %
= LED
1
¢ T

TI13974a
ETHERNET (NIC)

FIG. 5: Graco Gateway Port Pin Outs

3

FTrrrrn
(L1

TI13972a

FIG. 6: RS485 Communication Port (Typical ProMix 2KS Connection)
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Install the Gateway Module Hardware

RS232/PG
e = (=
X ][ som OR _
(4 : ;)'(I'S =
SiH|
USB/PG N
OR
D \9/ 0000 O
{=n
ETHERNET TI13969a
[I,:ll Green/Amber LED
B velow LED
FiG. 7: Programming Ports
RS232/PG
=1|cts —
O ==l Rx
Q —||comm
I | ==
—||rTs ﬁ:ﬁ
=
\C)/ 000 O
OR
— o 1
—n
e | =
— TI13970a
FiG. 8: RS232/PG Communication Ports
RS232
$TS : J_]j .,
s 3 So===In
Rx - o =
c1s ||= = = % P E]
e .
TI13971a
FiG. 9: RS232 Communication Ports
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Install the Gateway Module Hardware

ETHERNET

l Green/Amber
Bl velowLED

Fic. 10: Ethernet Connection

Standard Ethernet Cable
=} {=m)

TI13973a

Mount the Control on DIN Rail

The Gateway control mounts on a DIN rail. Tilt the con-
trol and push down onto the DIN rail, then push in. See
FIG. 11. A minimum clearance of 1 in. (25 mm) above
and below the control is required to ensure adequate
ventilation.

4

TI13965a
7
/ L}
}
1in. (25 mm)
minimum
clearance top
and bottom
\’ J
i
TI13966a

FiG. 11: Mount the Control on a DIN Rail

12

Install CompactFlash® Card

The CompactFlash socket accepts either Type | or Type
Il cards. These cards are available at most computer
and office supply retailers. Use cards with a minimum of
4 Mbytes and a maximum of 2 Gbytes. Use the Com-
pactFlash card for optional database storage only. See
FiG. 12.

Insert card with top side
on the left. Do not insert
or remove card while

power is applied. TI13967a

FiG. 12: Install a CompactFlash Card
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Install the GracoConfig Software

Install the GracoConfig Software

GracoConfig software provides access to the Graco
Gateway module hardware. The CD provided contains
the GracoConfig software (GracoConfigXXX.exe, where
the XXX represents the version control number). It also
includes a preconfigured database which is essentially a
setup file for the Gateway. The database file has a .gg2
extension.

The Graco Gateway provides conversions for many pro-
tocols, including the following:

e All Allen-Bradley protocols
* DeviceNet

* Ethernet TCP/IP

* Ethernet IP

*  Mitsubishi

e Modbus (ASCII, RTU)
*  Profibus

e Siemens

NOTE: Graco provides expansion cards for DeviceNet
and Profibus protocols. DeviceNet setup procedures are
on page 43. Profibus setup procedures are on page 58.
See page 41 for Parts.

NOTE: Contact your Graco distributor or Graco Techni-

cal Assistance for information regarding additional sup-
ported protocols.

312785D

System Requirements

GracoConfig software will run on PCs with the following
specifications:

* A Pentium class processor as required by the cho-
sen operating system.

NOTE: GracoConfig software will operate with all

versions of Microsoft® Windows 98 and above. Win-
dows 2000 or above is recommended for more
robust operation.

« RAM and free disk space as required by the chosen
operating system.

¢ An additional 50MB of disk space for software
installation.

« Adisplay of at least 800 by 600 pixels, with 256 or
more colors.

* USB port for downloading a configured database to
the Gateway module.

13



Install the GracoConfig Software

Load the Software

1. Connect the USB cable (23, supplied) between the
USB port on the Gateway module and a USB port

on your PC. See FIG. 13.

USB Port

(@)

\
0 N\ =

&

o
o
———2

i el
J 1TJ 4
TI12930a
USB Cable Strain Relief

FiG. 13: Gateway Module USB Port

2. FIG. 14 will appear. Select “Yes, this time only”, then
click Next.

Welcome to the Found New
Hardware Wizard
Windows will zearch for current and updated software by

looking on your computer, on the hardware installation CD, or on
the "windows Update ‘Web site [with pour permizzion).

Eead our privacy policy

Can 'Windows connect to Windows Update to search for
software?

(&) Yes, this time oy
() 'Yes, now and every time | connect a device
() Mo, not this time

Click. Mest to continue.

I MHexst » ][ Cancel

FiG. 14: Found New Hardware Screen

14

3. FiG. 15 will appear. Insert the CD in your PC'’s
CDROM drive. Select “Install the software from a list
or specific location”, then click Next. The program
location is C:\Program Files\Graco\GracoCon-
fig\Device.

NOTE: The name of the driver may be different.
Just accept the name and proceed by following the
instructions on the screen.

Found New Hardware Wizard

This wizard helpz pou install zoftware for:

M5-Connect 5100

\') If your hardware came with an installation CD
i or floppy disk, insert it now.

Wwihat do you want the wizard to do?

() Irstall the software automatically [Fecommended)
(@) Install fram a list ar specific location [Advanced)

Click Mest to continue.

[ < Back ” Mext » l[ Cancel

FiG. 15: Load Software from a Specific Location

Software Updates

Contact your distributor or Graco Technical Assistance
for software updates.

312785D



Download the Preconfigured
Database to the Gateway
Module

Graco supplies a preconfigured database as a setup file
for the Gateway, containing parameters which commu-
nicate between the Gateway and the ProMix 2KS. The

file name has a .gg2 extension.

GracoConfig files are downloaded to the Gateway mod-
ule using the Link menu. The programming link between
the PC and the Gateway module uses the USB cable.
Before downloading, check that the Communications
Port is set to USB, as follows.

NOTE: During programming the Gateway module may
ask for an updated driver. Follow the instructions on the
screen to automatically find and select the drivers.

1. Goto Start>Programs>Graco>GracoConfig and run

the program. The GracoConfig main page will
appear.

Link Pulldown Menu

Update Symbol

gz 2KS_Gatewa, |E 0BO108 - Gateway LE - Craco Config
File Edit Wiew Link Help

Install the GracoConfig Software

2. Using the Link pulldown menu, select Options to

open the Link Options window. Check that the Com-
munications Port is set to USB, and click OK.

Link Options

— Cammunications Park
oMy

oMz
 ComM3

" TCRIP | 0. . 0
I 89 [T Slow Link

Cancel |

TCF Pork

o]

FiG. 17: Set Communications Port to USB

DweE |72 % b&EX|0O)| 2|

Fic. 16: GracoConfig Main Page

312785D

3. Go to File>Open and select the file with the xx.gg2

extension. The file name should appear at the top of
the window (FIG. 16) once loaded.

4. Download the database using the Link>Update

command. As a shortcut, use the Update 4~ |
symbol on the toolbar. See FIG. 16.

NOTE: Downloading typically takes only a few sec-
onds but may take longer if the software has to
update firmware on the Gateway module.

15



Graco Gateway Network Communications Configuration

Graco Gateway Network Communications

Configuration

Startup

To run GracoConfig, select the icon -t:" from the

Graco folder on the Programs section of your Start
Menu. The main page will appear, showing the Commu-

nications button.

Communications Button

uor 2KS, Gateway LE_DBO10B - Gateway || - Graco Config
File Edit Yiew Link Help

0w &

/% mE X |0 4\

FiG. 18: Communications Button

16

GracoConfig Main Page

Communications Button

The Communications button provides access to screens
used to configure your system and setup parameters,
allowing you to:

»  Specify which protocols are to be used on the Gate-
way serial ports and on the Ethernet port.

» If using master protocols (i.e., protocols by which
the Gateway initiates data transfer to and from a
remote device), you can specify one or more
devices to be accessed.

» If using slave protocaols (i.e., protocols by which the
Gateway receives and responds to requests from
remote devices or computer systems), you can set
read or write access for specific data items.

* Move data between one remote device and another.

Balloon Help

The Balloon Help feature allows you to see help infor-
mation for each icon in the main menu, or for each field

in a dialog box or window. It is controlled via the h
icon at the right-hand edge of the toolbar. Balloon Help
has three user-selectable modes:

» Do Not Display disables balloon help
*  When Mouse Over displays help when the mouse
pointer is held over a particular field for a certain

period of time

* When Selected displays help constantly for the cur-
rently selected field.

312785D



Graco Gateway Network Communications Configuration

Setup the Database

1. Double-click on the Communications button to open
the preconfigured database (.gg2). The file is
already setup for ProMix 2KS. See FIG. 19.

427 7KS_Gateway LE_0B0108 - Gateway LE - Graco Config
File Edit View Link Help

D@ d|7stbmx|ofs |

Communications

[l
) Programming Port
=l R5-232 Comms Pork Driver: I Modbus TCP(IP Slave
= -U] R5-485 Comms Port - Modbus Master
I PraMix2Ks ~Driver Settings
[=l-=& Ethernet
¥ Protocal 1 - Modbus TCPIP sla\%
% Protocal 2 Sessian Limit: I 2
-5 Protocol 3
-5 Protocol 4
Services
m OPC Server In Long Blocks: ILow Then High

~Driver Selection

TCP Port; S0z

—Word Ordering

In Real Blocks: ILow Then High

~Driver Security

Server Access: IDo Mok Restrick

Permitted PData: [ O . O

Permitted IP Mask: I o . o

Clear Port Settings Add Additional Device

Fic. 19: Preconfigured Database

2. See FIG. 20. Highlight Protocol 1. Click the Edit but- lists provided, in this example Modbus and TCP/IP
ton on the right side of the window to open the Slave. The system will create device PLCL1.
Driver Picker window. Choose a protocol from the

£t 2KS_Gateway | E_0B010B - Gateway LE - Graco Config
File Edit g

Ded|Zsmm X |0 %]

Link.  Help

Communications =]

ERE| E)ﬂ?IPP - | Driver Selection
[ ) Rzg?:?;;gmsogort Driver: I Modbus TCPJIP Slave
E =] R5-485 Comms Port - Modbus Master
[ ProMixzKs = |
==& Ethernet Driver Picker for, Ethernet Port X
[+-%" Protocol 1 - Modbus TCRIIP Slave S
; ?;- Pratacal 2 —Manufacturer i Drriver
8 Protocol 3 Mo Driver Selected
8 Protocol 4 Encapsulated Modbus Master ‘Wersion 1,01
E% Services TCP/IP Master Version 1,05

Ve Nmn 1.02

TP oPC Server

Permitted IF Mask:

Clear Port Settings | Add Additionial Device |

FiG. 20: Select Protocol
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Graco Gateway Network Communications Configuration

3. SeeFIG. 21. Right click on device PLC1 to rename it
to something meaningful for your system.

27 2KS_Gateway LE_0BO108 - Gateway LE - Graco Config
File Edt wew Link Help

D@ d|” s b@ x|z

Communications
i Dsp

=) RS-485 Comms Port - Modbus Master

Device Settings

Programming Port
RS-232 Comms Port [ Enable Device

I~ Favour UL 'Writes

Cormms Delay: I 0 ms

I ProMixzks
=& Ethernet

Delete This Device

Add Gateway Elock |

=8 Protocol 1 - Modbus TCPIIP Slave
o
S Protocol 2
S Protocol 3
S Protocol 4

% Services

- If oPC Server

FiG. 21: Rename PLC1

4. See FIG. 22. Add as many Gateway blocks as
desired under each device.

dgr 2KS_Gateway LE 080108 - Gateway LE - Graco Config
File Edit Wew Link Help

Ded|7sbmx|o|#)|

Communications
ENE =
=) Programming Port ’7

=) RS-232 Carmms Port

Device Settings

¥ Enable Device

™ Favour UL Writes

Comms Delay: I 0 ms

==l RS-485 Comms Pott - Modbus Master
T ProMixzks
== Ethernet

Delete This Device

Add Gatewﬁy EBlock |
&

=% Protocol 1 - Madbus TCRJTR Slave

o Elock 4
- ® BlockS
% Protocol 2
% Protocol 3
% Protocol 4
EI--% Services
m COPC Server

FiG. 22: Add Gateway Blocks

18
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Map Data

1. See FIG. 23. Select the block for data mapping. 2.
Click the Edit button next to the Start Address field
on the right side of the window. The Select Address

window will open.

CoOKS Gateway LE (

Graco Gateway Network Communications Configuration

Refer to Table 4 on page 31 for a Modbus map.
Select the desired Modbus register address as a
starting point (in this case 40002). Enter the appro-

priate values in the Select Address window and click
OK. The desired register address will populate the
Start Address field.

0108 - Gateway LE - Graco Config

=) Prograrnming Port
=) R5-232 Camms Part
(= =) R5-485 Comms Part - Madbus Master
- ProMixzks
[zl <A Ethernet
- =¥ Protocol L - Modbus TCRIP Slave
.| E-mmepct
i [+ ® Elock 1
[+ ® Block2
[+ ® Block3
[+ M Block4
H [+ ® Blocks
W Protocol 2
W Protocol 3
W Protocol 4
El % Services

- IBp opc Server

FiG. 23: Mapping Gateway Blocks

~Block Settings

Start Address: | 400002

Block Size: I 7

Direction: I Device to 53

Select Address for Modbus TCP/IP Slave

~Data Ikem

Mo Selection

Analog Inputs
Digital Coils
Digital Inputs

~Daka Type

|Word as Long
Wword as Real

— Element

4 ooz

I~ gigned Mode (16-bit)

~ Details
Type:
Minirmumm:
Maximurn:
Radix:

‘Word

400001
465535
Decimal

o]

312785D

19



Graco Gateway Network Communications Configuration

See FIG. 24. Click the Edit button next to the Block
Size field on the right side of the window. The Edit
Value window will open. Enter the number of Mod-
bus register addresses in the range from the starting
address entered in step 2 to the desired ending
address, inclusive. In this example, 7. The
addresses must be contiguous. This means that
each address must be available and addressable
from the ProMix 2KS. If one of the 7 addresses does
not exist within the ProMix 2KS Modbus structure,
the complete block will not communicate.

2K5_Gateway LE 0B010B - Gateway LE - Graco Config

~ Black Settings

=) Prograrmrming Part

=] R5-232 Comms Part Start Address: l400002

[=-=l) R5-485 Comms Part - Modbus Master

[ ProMixzks Block Size: |7

I=1- =% Ethernet

Direction; I Device to G3

=& Protocal 1 - Modbus TCPJIP Slave

[~ Block Contral

Edit Value

~Block Size
+- W Blocks l F]

% Protocol 2 |

% Protocol 3 lete This Block
B Protocol 4 | Gl | I

“iew Block. ..

=14y Services
IR oPC Server

FIG. 24: Setting Block Size

20
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Graco Gateway Network Communications Configuration

4. See FIG. 25. Click OK. The range of addresses will NOTE: In this example, a Modbus device master
appear under the appropriate Block on the left side communicating via TCP/IP will have direct access to
of the window. Modbus registers 40002 through 40008 of the Pro-

Mix 2KS.

For example, see Block 1 address line 1:

W Flock 1
X l4IZIIIIIIIIZIEI«»IPrnMiszSADDDDEI

Modbus address
of ProMix 2KS.
Modbus address

(command) from TCP/IP
master connected to

5. The Direction field typically should remain set to
Device to G3.

27 7KS_Gateway LE_0BO108 - Gateway LE - Graco Config
File Edit View Link Help

D& d
[ ]
=14 ose Elock Settings
=1 Programiming Port
=0 R5-232 Comms Port Start Address: |4DDDDZ Edit...
=1-=l] RS-485 Comms Pork - Madbus Master E - |?
[ ProMixzks ok Sles
—|-=A Ethernet P - =
Direction: Device to G3 Edit...
=% Protocal 1 - Modbus TCPJIP Slave | J
=-H PLCL
- m Block 1 Block Contral

¥ 400002 «» ProMix2K5, 400002 ‘
¥ 400003 «» ProMix2K5, 400003

X 400@ w ProMixzKs, 400004 [
¥ 400085 «» ProMix2KS, 400005

X

X

x

400006 < Profix2K3, 400006

400007 +» ProMix2K5, 400007 Export to File. .. ‘ Delete This Block Wiew Block, .. |
400005 < Profix2K5, 400005

m Blockz

m Block3

m Block 4
+- W Blocks

W Protocol 2

W Protocol 3

W Protocol 4

= % Services

E CPC Setver

EAREIE

Fic. 25: Block Mapping Data

312785D 21



Modbus and I/O Data

Modbus and I/O Data

See Table 4 through Table 5 for Modbus register
addresses and input/output data.

Reference the Discrete I/O listing of all the inputs and
outputs (see page 31). Ensure these are fully under-
stood. The same implementation used for Discrete /O is
used for the Network communication protocol.

For example: The Gun Trigger Input will now be a spe-
cific bit of Modbus Register 40040. Monitoring of Mod-
bus Register 40041 for specific output status conditions
will be required as explained in the Discrete 1/O section
of the ProMix 2KS Operation manual. The PLC will have
to read the various bits, and in some cases (40040 and
40041 for example) must mask out the various bit posi-
tions to determine each of the separate input and output
statuses. This requires experience and should not be
done on the job site. A full understanding of the color
change process as well as the required timing of various
inputs and outputs is required.

NOTE: Analog input for flow control set point will now be
a dedicated Modbus register. Register 40137 will

require the specific flow rate (i.e. 125 cc/min). This is not
a voltage reading but the actual flow target.

Start Mix Process

See FIG. 26, Table 1, and Table 2.

1. Verify that the Mix Ready bit (bit 2 of 40041) is on.
2. Turn on the Mix bit (bit 7 of 40040).

3. Verify that the Mix Active bit (bit 1 of 40041) is on, to
ensure that the Mix request was received.

Stop Mix Process

See FIG. 27, Table 1, and Table 2.

1. Clear the Mix bit.

22

2. The Mix Active output should clear and Mix Ready
should now be set.

NOTE: The ProMix 2KS will automatically go into Idle
mode after 2 minutes of inactivity. A general alarm will
be present and Mix Active will remain High. The Alarm
bit (40010) will indicate the system Idle alarm. When a
new Gun Trigger input is seen, the ProMix 2KS will
resume mixing material where it left off. Do not toggle
the Mix bit; doing so restarts the Mix process from the
beginning.

Color Change Process

See FIG. 29, Table 1, and Table 2.

1. Verify that Mix Ready is set. This ensures that there
are no alarms and that the system is ready for the
next command.

2. Load ccNewRecipe (Modbus 40046) with a recipe
number to color change to.

3. Set color change (40040 bit 6).
4. Verify that Purge_CC_Active is seen (40041 bit 0).
5. Clear color change bit (momentary only).

6. Do not change the ccNewRecipe value until a new
recipe change is requested.

7. The color change process will stop automatically as
programmed. Monitor Purge_CC_ Active bit for com-
pletion.

Purge Process

See FIG. 28, Table 1, and Table 2.

1. Verify that Mix Ready is set. This ensures that there
are no alarms and that the system is ready for the
next command.

2. Set purge (40040 bit 8).
3. Verify that Purge_CC_Active is seen (40041 bit 0).

4. When Purge_CC_Active bit clears, clear
Purge_Start bit. Clearing this bit in the middle of a
purge sequence will abort the purge sequence.
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NO

Must be Alarm Condi-
tion or Active Recipe
61. See Alarm Pro-
cessing on page 27,
or Startup from Rec-

ipe 61 (see NOTE

Modbus and I/O Data

Start Mix Mode
Process

YES

Is Mix Ready
bit=17?

Set Mix bit = 1

NO

Is Mix Active
bit =17

NOTE: At power up the system
defaults to Recipe 61, which is
not a valid recipe number. Initiate
a color change to Recipe 0 or a
valid recipe number (1-60).

Fic. 26. Start Mix Mode Process Flow Chart

ProMix 2KS in Mix
Mode (Complete)
Mix Active = 1 while
the ProMix 2KS is in
Mix mode

312785D
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Modbus and I/O Data

NO

Check Alarm
Condition: is Alarm_

Mixing Mode
Process

Mixing Mode is desired.
PLC is polling to ensure
Mixing Mode is main-
tained.

Is Mix Active
bit =17

YES

Mixing Process active

NO

2KS is in Standby. Go to

General bit=17

Start Mix Process, page
22.

Go to Alarm Process-

FiG. 27. Mixing Mode Process Flow Chart

ing, page 27

24
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Is Mix Ready
bit =17

Must be Alarm
Condition or Active
Recipe 61. See
Alarm Processing
on page 27, or
Startup from Recipe
61 (see NOTE

A

NO

(Wait for Mix Ready)

Is Mix Ready
bit = 1?

v

Set Purge bit =1?

Is Purge_CC_Active
bit=1?

Modbus and I/O Data

YES

ProMix 2KS in
Purge_CC Mode
(Process Started)

NOTE: At power up the system
defaults to Recipe 61, which is
not a valid recipe number. Initiate
a color change to Recipe 0 or a
valid recipe number (1-60).

FIiG. 28. Purge Mode Process Flow Chart

Set Purge Bit = 0.
ProMix 2KS Purge
Process (Complete)

312785D
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Modbus and I/O Data

Color Change
Process
(basic)

Do nothing.
Spraying at
desired recipe.

Is Active Recipe =

NO

to desired recipe?
(Register 40005).

Ensure Col-
orChange bit is
seen by ProMix

Is Purge_CC_Ac-
tive bit = 1?

NO

\ 4

Load ccNewRecipe
(Register 40046) with
recipe number to Color
Change to (0 through
60 is valid).

\ 4

Set ColorChange (CC)
bit = 1.

Clear ColorChange (CC)
»| bit (momentary input).

NO (Wait for Mix Ready)

A

CC process started.

Is Mix Ready
bit=17?

Check Alarm

ProMix 2KS Color

Condition: is Alarm_
General bit =1?

> Change Process

(Complete)

\

Process Alarm. See
Alarm Processing,
page 27.

FIG. 29. Color Change Mode Process Flow Chart

26
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Alarm Processing
See FIG. 30, Table 1, Table 2, and Table 3.

Alarm Processing

v

An Alarm Condition
has been found
previously. Alarm_-
General = 1.

Check if Potlife
Alarm: is Alarm__
Potlife bit = 1?

NO

Determine the exact alarm
from Table 3 on page 30
and solve what caused the
alarm, as required.

i

Reset the alarm.
Reset_Alarm = 1.

YES

Is Mix Ready

Modbus and I/O Data

YES

Two options:

» Purge or Color Change to remove
mixed material in the line.

* Place in Mix mode and spray the
Potlife Volume set in the ProMix
2Ks.

NOTE: The Reset key only silences
the alarm. To clear the alarm you must

use one of these two options.

bit = 1?

Fic. 30. Alarm Processing Flow Chart

Go to next process,
as desired.
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Modbus and I/O Data

Table 1: ProMix 2KS Digital Inputs (Modbus Register 40040)

Bit |Digital Input Binary Name Details

0:5 |0|0(0|0[{0|0[0|0|0|0|X[X|X|X|X|X|Recipe Binary bits for viewing discrete inputs only.

6 0/0(0|0|0|0|0|0(0|1]|0|0|0[0|0|0|Color Change |Set bitto “1” to initiate Color Change (momentary)

(CC)

7 0(0|0|0|0|0|0|0(1]|0|0|0|0|0|0|0|Mix Set bit initiate Mix mode (maintain)

8 0(0|0|0|0|0|0|1|0|0(0|0|0|0O|0|0O|Purge Set bit to “1” to initiate Purge sequence (maintained)

9 0/0({0(0|0|1|0|0(0|0|0|0|0|{0|0|Job_Complete |Set bitto “1” to initiate Job Complete input (momen-
tary)

10 0(0|0|0|0|1|0|0|0|0(0|0|0|0O|0|0O|EXternal CC Set bit to “1” to initiate External Color Change

Ready (momentary)

11 |0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0O|Not Used

12 0|0 0|0{0(0|0|0|0|0|0|0|0|FC _Calibrate |Set bitto “1”to initiate a Flow Control Calibrate input
(momentary)

13 0(0|1/0|0|0|0|0(0|0|0|0|0|0|0|0|Gun_Trigger |Set bitto “1” to indicate the gun is actually triggered
(maintain while gun is triggered, remove when gun is
closed)

14 O|Reset_Alarm |Set bit to “1” to clear an active Alarm (momentary)

15 0/0{0|0|0|0|0[|0|0|0|0|0|0|0|0|Remote Stop |Set bit to remotely stop unit (momentary)

NOTE: Shaded cells relate to the flow charts on pages 24-27.
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Modbus and I/O Data

Table 2: ProMix 2KS Digital Outputs (Modbus Register 40041)

Bit |Digital Input Binary Name Details

0 0/0|0|0|0|0|0|0|0|0|0|0|0|0|0|1|Purge CC Active |“1"indicates Purge or Color Change is in prog-
ress

oj0|0|0|0O|0O|0O|0O(0O|0O|0O|0O|O 0 [Mix_Active “1” indicates Mix is in progress

2 0/0{0(0|0|0|0|0(0|0|0|0|0[1|0|0|Mix_Ready “1” indicates No Alarms and OK to Mix

3 0(0|0|0|0|0|0|0|0O|0O|0|0O|1|0|0|0O|CC_Fill_Active “1” indicates the Fill portion of a Color Change is
in progress

4 0/0|0|0|0|0|0|0|0|0|0|1|0|0|0|0|FCalActive “1” indicates the Flow Control Calibrate routine is
in progress

5 0|0|0(0|0|0|0|0|0|0|1|0|0|0|0|0|Flow_Rate_Alarm |“1” indicates the Flow Rate Alarm/Warning is
active

6 0(0|0|0|0|0|0|0(0|1{0|0|0|0O|0|0O|Special_1 “1” indicates the Special_1 output is on (monitor
only)

7 0(0|0|0|0|0|0|0f1|0[|0|0|0|0O|0|0O|Special_2 “1” indicates the Special_2 output is on (monitor
only)

8 0|0(0(0|0|0|0|1({0|0|0|0|0|0|0|0O|Special_3 “1” indicates the Special_3 output is on (monitor
only)

9 0(0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|Special_4 “1” indicates the Special_4 output is on (monitor
only)

10 0 [Not Used

11 |0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0O|Not Used

12 0j0|0|1|0|0|0|0O|0O|O|O|O|0O|0O|0O|0O|Alarm_General “1” indicates a General Alarm is in process. (If
Mix_Active is still High, then a Warning only.)
See ProMix 2KS Active Alarms (Modbus Reg-
ister 40010) on page 30 for details on type.

13 0(0|1|0|0|0|0|0|0O|0O|0|0O|0|0O|0O|O|Alarm_Paotlife “1” indicates a Potlife Alarm is in process.

NOTE: Shaded cells relate to the flow charts on pages 24-27.
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Modbus and I/O Data

ProMix 2KS Active Alarms (Modbus Register 40010)

Table 3: ProMix 2KS Active Alarms (Modbus Register 40010)

30

Bit Digital Input Binary Name Details
Low Byte: 0 0000 0000 0000 0000 No Bits Set No Active Alarms
Low Byte: O 0000 0000 0000 0001 Comm_Error

Low Byte: 0 0000 0000 0000 0010 Potlife_Alarm

Low Byte: 0 0000 0000 0000 0100 Ratio_High_Alarm

Low Byte: O 0000 0000 0000 1000 Ratio_Low_Alarm

Low Byte: 0 0000 0000 0001 0000 Overdose_A_Alarm

Low Byte: 0 0000 0000 0010 0000 Overdose_B_Alarm

Low Byte: 0 0000 0000 0100 0000 Dose_Time_ A _Alarm
Low Byte: 0 0000 0000 1000 0000 Dose_Time_B_Alarm
Low Byte: 0 0000 0001 0000 0000 Mix_In_Setup_Alarm
Low Byte: O 0000 0010 0000 0000 Remote Stop_ Alarm
Low Byte: 0 0000 0100 0000 0000 Purge_Volume_Alarm
Low Byte: O 0000 1000 0000 0000 CC_Comm_Error_Alarm
Low Byte: 0 0001 0000 0000 0000 High_Flow_Alarm

Low Byte: 0 0010 0000 0000 0000 Low_Flow_Alarm

Low Byte: 0 0100 0000 0000 0000 System_Idle_Alarm

Low Byte: 0 1000 0000 0000 0000 Setup_Change_Alarm
High Byte: 0 {0000 0000 0000 0001 Power_On_Alarm

High Byte: 0 {0000 0000 0000 0010 Defaults_Loaded_Alarm
High Byte: 0 |0000 0000 0000 0100 IO_Alarm

High Byte: 0 |0000 0000 0000 1000 Purge_lInitiate_Error
High Byte: 0 {0000 0000 0001 0000 Material_Fill_Alarm

High Byte: 0 {0000 0000 0010 0000 Tank_A_Low_Alarm
High Byte: 0 {0000 0000 0100 0000 Tank_B_Low_Alarm
High Byte: 0 |0000 0000 1000 0000 Tank_S_Low_Alarm
High Byte: 0 {0000 0001 0000 0000 Auto_Dump_Complete
High Byte: 0 |0000 0010 0000 0000 Color/Catalyst_Purge_Alarm
High Byte: 0 {0000 0100 0000 0000 Color/Catalyst_Fill_Alarm
High Byte: 0 {0000 1000 0000 0000 Num_Alarm_Desc

High Byte: 0 {0001 0000 0000 0000 Spare3_Alarm

High Byte: 0 {0010 0000 0000 0000 Spare2_Alarm

High Byte: 0 {0100 0000 0000 0000 Sparel_Alarm

High Byte: 0 {1000 0000 0000 0000 Potlife_Buzzer
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ProMix 2KS Modbus/TCP Variable Map

Table 4: ProMix 2KS Modbus/TCP Variable Map

Modbus and I/O Data

EasyKey
* Read/Write| Modbus
Status Register Description Size Units Low Limit | High Limit
Read Only 40003 | Current flow rate 16 Bit cc/min 0 5000
Read Only 40004 | Actual ratio 16 Bit none 0 9999
Read Only 40005 | Active recipe 16 Bit none 0 60
Read Only 40006 | Potlife 1 remaining 16 Bit sec 0 9999
Read/Write 40007 | Job complete 16 Bit none 0 OXFFFF
Read/Write 40008 | Reset job total 16 Bit none 0 9
Read Only 40009 | Potlife 2 remaining 16 Bit sec 0 9999
Read Only 40010 | Active fault 32 Bit none 0 Oxffffffff
Read Only 40032 Control version 32 Bit none 0 Oxffffffff
Read/Write 40040 | Robot digital input 16 Bit none 0x0000 OXFFFF
Read Only 40041 | Robot digital output 16 Bit none 0x0000 OXFFFF
Read/Write 40046 | New recipe 16 Bit none 0 60
Read Only 40048 | Current fluid pressure 16 Bit psi 0 5000
Read Only 40049 | V/P percent output 16 Bit % 0 100
Read Only | **40056 | Actual ratio reducer 16 Bit none 0 9999
Read Only 40114 Flow control option 16 Bit O=proportioning only 0 4
1=1K flow control
(future)
2=2K flow control
3=pressure override
4=manual percent
override
Read/Write 40115 Flow setpoint data source| 16 Bit O=discrete 0 1
1=network
Read/Write 40120 Manual override percent 16 Bit % 0 100
opening
Read/Write 40125 Flow control range 16 Bit 0=0-300 cc/min 0 2
1=0-600 cc/min
2=0-1200 cc/min
Read/Write 40126 Flow control tolerance 16 Bit % 0 99
Read/Write 40127 Flow control proportional 16 Bit default=400 0 9999
gain Kp
Read/Write 40128 Flow control integral gain 16 Bit default=40 0 9999
Ki
Read/Write 40129 Flow control alarm time 16 Bit sec 0 99
Read/Write 40137 | Flow control setpoint 16 Bit cc/min 0 1200
Read/Write 43123 | Flow control override 16 Bit 0=off (normal) 0 2
mode 1=% open
2=pressure mode
Read/Write 43141 Flow control enable 16 Bit O=off 0 1
1=on

*  This column represents the rule that must be implemented by automation. Writing to Read Only registers must be

avoided.

** For ProMix 3KS Systems only.
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Modbus and I/O Data

ProMix 2KS Recipe Bits

Table 5: ProMix 2KS Recipe Bits

Number

Recipe Bits

33
34
35
36
37

38
39
40

41

42

43

44

45

46

a7

48

49

50
51

52
53
54
55
56
57
58
59
60

0

1
1

1
1
1
1

0f 0] 0L O

0| O
0| O

0f 0] 0 O

0| O
0| O
0| O
0| O

1
1

1
1
1
1

Number

10
11
12
13
14
15
16
17
18
19
20
21

22
23
24
25
26
27

28
29
30
31

32

Recipe Bits

0 0/ O

0 0/ O

1

0l 0 0O O
0f 0 O

0

0l 0 0 0Ol O

0l 00 0 0Ol 0 O
0l 0 0 Ol O
0l 0 0O O
0f 0/ 0/ O
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Troubleshooting

NOTE: This section covers the most common problems
encountered while setting up, programming or using the
product. Do not forget to always download in the device
after changing settings in Graco Gateway.

General Troubleshooting

Troubleshooting

PROBLEM

CAUSE

SOLUTION

Unit screen is blank and PWR LED is
off.

No power applied to the unit.

Check power supply. Units require 24
VDC, + 10%.

Unit screen is blank and PWR LED is
on.

Contrast too low (Graco Gateway
only).

Program one of the soft keys with the
action as User Defined and the fol-
lowing code in the field On Pressed:
dispcontrast++

No primitives on the display.

Add objects to the User Interface in
Graco Gateway.

Backlight is off.

Push one of the soft keys to turn it
back on.

Backlight tube is broken.

Replace the backlight tube.

Unit continually cycles on and off.

Cross-references between tags, e.g.,
Varl uses Var2 as maximum which
in turn uses Varl as minimum.

Remove one of the references or use
formula tags for indirect reference,
e.g., Forml is equal to Varl and
used in Var2 minimum instead of
Varl.

Database is corrupted.

Create a new database or send to
technical support for debugging.

Unit cycles power after an operation.

Most likely a program going in an
endless loop.

Check if the operation launches pro-
gram containing loops with no exit
point.

CF LED flashing slowly.

CF card corrupted or invalid.

Format the card from Graco Gateway
using the Link > Format Flash menu.

312785D
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Troubleshooting

CAUSE

SOLUTION

PROBLEM

Unit shows “Version Mismatch”.

The database currently in the device
does not match Graco Gateway'’s
firmware version. (Message occurs
after a download with a new version
of C2 interrupted before the database
was downloaded.)

Download the database from Graco
Gateway again.

Unit shows “Invalid Database”.

The database in the device is cor-
rupted or there are no databases in
the device.

Download a database from Graco
Gateway.

Values show “----"

No communication with target device.

See Serial Communication Trou-
bleshooting (page 37) or Ethernet
Communication Troubleshooting
(page 38).

Value does not update.

The tag on the screen is not linked
correctly.

Check the tag mapping making sure
the target device (PLC, etc.) register
is correct.

Check the primitive Data Source in
the user interface in case the word
WAS is displayed. Re-link the tag in
this case.

Value shows +BIG or —BIG.

Not enough digits before the decimal
point to show the number. For exam-
ple, data is 1000.5 and format is
three digits before the decimal point
and one after.

Increase the number of digits before
the decimal point in the tag format.

Value deviates by a factor of ten.

The tag format is not correct.

Change the decimal point position in
the tag format.

Value is invalid.

Incorrect tag type.

Check if the tag type corresponds to
the data type. Is the data a floating
point number and thus the tag a real
(Pi symbol), and not an integer (X
symbol)?

Incorrect data mapping.

Check if the tag is accessing the cor-
rect target device register.

Incorrect primitive on the display.

Check if the primitive corresponds to
the tag type. For example, primitive is
a Text Integer so the tag has to be an
integer.

Data received is not what's expected.
For example, bytes reversed in the
word.

Use the transform property on the tag
to modify the data source. You might
have to try multiple solutions to solve
the issue.
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Troubleshooting

PROBLEM

CAUSE

SOLUTION

Symbol or image leaves a trace when
animated.

The background of the image is not
refreshed.

Change the primitive Fill Format to
Solid color.

Add the system variable dispcount
in the background of the image to
force the refresh.

Rich Bar Graph or Dial Gauge does
not move

Tag minimum and maximum are not
setup.

Check the tag’s minimum and maxi-
mum values. These are used by both
primitives for minimum and maxi-
mum.

Trend Viewer curve stuck at the bot-
tom.

No minimum and maximum setup on
the data tags displayed in the viewer.

Check that all displayed tags in the
trend viewer have a Minimum and a
Maximum setup.

USB Drivers location for Windows.

Location of the drivers unknown.

The drivers are located under Graco
Gateway 2.0\Device installation
folder. For example C:\Program
Files\Graco Gateway\Device.

USB Diriver installation.

The operating system is unable to
find the driver or the installation
failed.

In your operating system device
manager, check if the Graco Gate-
way is present. If so, uninstall that
device. Follow the USB installation
guide.

Upgrading Graco Gateway did not
upgrade the software version.

The option selected during the
upgrade was Modify instead of
Repair.

Launch the upgrade again and
choose Repair when prompted.
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Troubleshooting

Graco Gateway Messages Troubleshooting

PROBLEM

CAUSE

SOLUTION

Device incompatible with file.

The device you are trying to down-
load into doesn’t match the database
device.

Create a new database file corre-
sponding to your device (File > New).

Unable to open communication port.

The communication port you try to
download with is unavailable:

e Cable not connected.

Check if the cable is connected cor-
rectly to the PC and the device pro-
gramming ports (USB or PG Port).

* Incorrect download communica-
tion port.

Check that Graco Gateway is
directed to the correct communica-
tion port (Link > Options).

» Port already used.

Check that the communication port is
not used by another service or soft-
ware especially for serial ports.

» Target device IP address incor-
rect.

If you download via Ethernet, check
the IP address of the target device in
Link > Options.

* No USB Drivers.

Check that the USB drivers were
installed successfully. Reinstall
Graco Gateway USB driver under the
PC device manager if necessary.

No reply from terminal.

Cable is not connected.

Make sure the cable is connected or
check above solutions.

If the message appears while down-
loading to the device.

Download again with Link > Update
or F9.

CompactFlash required for upgrade.

The version of Graco Gateway on the
PC is different from the target device
firmware version when attempting a
download via Ethernet.

Insert a CompactFlash Card in the
target device.

Use another communication port for
download: USB or Serial.

The window is too small to allow edit-
ing.

The current User interface view is too
small to allow editing.

Change the panel view using View >
Panel > Display only.

The device returned an unexpected
reply code.

The device you are trying to down-
load to is not supported by this ver-
sion of Graco Gateway.

Update Graco Gateway to the latest

version available (contact your Graco
distributor or Graco Technical Assis-
tance). Choose Repair when upgrad-

ing.
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Serial Communication Troubleshooting

Troubleshooting

This section is used to troubleshoot the communication between two devices linked via serial ports, i.e. RS232 or

RS485.

TIP: For communication troubleshooting, it is strongly advised to create a new Graco Gateway database including
only one data tag mapped to a known register in the target device.

PROBLEM

CAUSE

SOLUTION

Values show “----"

Port settings do not match.

Check that the port settings of the
Graco Gateway device match the tar-
get device (i.e. Baud, Parity, etc.).

Incorrect target device address.

Check that the target device address
in Graco Gateway (in communica-
tions on the PLC symbol) matches
the target device address setup.

Incorrect cable.

Check the cable part number or
cabling to match your protocol.

Incorrect communication port.

Check if the cable is connected to the
correct communication port.

If the above is correct, check that the
protocol settings are on the correct
communication port in Graco Gate-
way.

Communication port connector pins
bent inward.

Although unlikely, check the commu-
nication port connector pins on the
Graco Gateway in case some are
bent inward resulting in a bad contact
with the cable.

Incorrect tag mapping.

Check that the tag is mapped to an
existing register in the target device.

Values blink between the data and

Incorrect tag mapping on one of the
tags on the display.

Delete tags one after another and
download in-between. When the val-
ues on the screen stop blinking, the
last deleted tag was mapped incor-
rectly or accessed an unknown regis-
ter in the target device.

Communications times-out.

Increase the Slave Response or
Device Timeout on the communica-
tion port or target device in Graco
Gateway.
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Troubleshooting

Ethernet Communication Troubleshooting

This section is used to troubleshoot the communication between two devices linked via Ethernet.

TIP: For communication troubleshooting, it is strongly advised to create a new Graco Gateway database including
only one data tag mapped to a known register in the target device.

PROBLEM

CAUSE

SOLUTION

Values show “----"

Incorrect target device IP address.

Check the target device IP address in
Graco Gateway (in communications
on the PLC symbol) to match the tar-
get device IP address setup.

Incorrect cable or wrong connection.

Check the LED on the Graco Gate-
way device Ethernet port. If none are
lit, there are no connections. Check
the cable or that the Ethernet port is
enabled in Graco Gateway, see
below.

Ethernet port disabled.

Check that the Ethernet port in Graco
Gateway is enabled.

Graco Gateway and target devices
are in a different address domain:

» If norouters are present on the
network.

Check that the target device IP
address and Graco Gateway device
IP address are different but in the
same domain. (For example, both
start with the same three first num-
bers; ex: 192.168.2.xxx if the mask is
255.255.255.0).

» If arouteris present on the net-
work.

Check the Graco Gateway device
Ethernet port Gateway address to
match the router IP address.

Incorrect tag mapping.

Check that the tag is mapped to an
existing register in the target device.

Values blink between the data and

Incorrect tag mapping on one of the
tags on the display.

Delete tags one after another and
download in-between. When the val-
ues on the screen stop blinking, the
last deleted tag was mapped incor-
rectly or accessed an unknown regis-
ter in the target device.

Communications times-out.

Increase the Slave Response or
Device Timeout on the communica-
tion port or target device in Graco
Gateway.

38

312785D



LED Functions

Status (STS) LED

The green Status LED provides information on the sta-
tus of the Graco Gateway, including various stages of

the startup routine and any errors that occur.

Troubleshooting

CompactFlash (CF) LED

Status Indication

Rapidly Graco Gateway is currently running the
Flashing boot loader and/or being upgraded.
Steady Graco Gateway is operating normally.

User Communication Ports - TX/RX LEDs

Status Indication

Off No CompactFlash card is present.

Steady Valid CompactFlash card is present.

Rapidly CompactFlash card is being checked.

Flashing

Flickering | Unit is writing to the CompactFlash
card, either to store data or because the
PC connected via the USB port has
locked the drive.*

Slowly Incorrectly formatted CompactFlash

Flashing card is present.

Status Indication
Green Transmitting
Red Receiving

Ethernet LEDs

Status Indication

Yellow Link Established

(Steady)

Yellow Network Activity

(Flashing)

Green 10 BASE-T Communications
Amber 10 BASE-TX Communications

312785D

*

Do not turn off power to the unit while this light is
flickering. The unit writes data in two minute inter-
vals. Later Microsoft operating systems will not lock
the drive unless they need to writer data; Windows
98 may lock the drive any time it is mounted, thereby
interfering with logging. Contact Graco Technical
Assistance for further information.
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System Electrical Schematic

System Electrical Schematic

Non-Hazardous Area
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Parts

15V331 Gateway Ethernet Kit (shown)
15V963 Gateway DeviceNet Kit

15V964 Gateway Profibus Kit

Ref. Ref.
No.  Part No. Description Qty No.
1 15V339 PANEL, back 1 11
2 15T752 COVER 1 12
3 n/a DIN RAIL 1 13
4 120369 POWER SUPPLY, 24 Vdc 1 14
5 15V345 GROMMET, cable entry 2 15
6 111987 CONNECTOR, strain relief 1 16
7 n/a WIREWAY 1 17
SA 186620 LABEL, ground 1
9 n/a COVER, wireway 1 18
10 CONTROL BOX, Gateway
10a 15V966 BOX, DeviceNet; includes 1 20a
items 20a, 23, and 27; used
on 15V963 Kit only 20b
10b 15v965 BOX, Profibus; includes items 1
20b, 23, and 27; used on 23
15V964 Kit only 25
10c 15X492 BOX, ethernet; includes items 1
23 and 27; used on 15V331 27
Kit only

Part No.

120838
103833
112443
15V344
121994
121700
n/a

n/a

15Vv347

15V346

157999
n/a

258527

Description

BLOCK, clamp end
SCREW, machine

BLOCK, terminal, ground
CONNECTOR

CABLE, CAT5

CABLE, 2 connector
WIRE, copper, 16 ga.; 9 in.
(230 mm)

WIRE, copper, 16 ga; 9 in.
(230 mm)

CARD, DeviceNet; 15V963
Kit only

CARD, Profibus; 15V964 Kit
only

CABLE, USB; not shown
SCREW, machine, serrated
hex-head

CD ROM, software, Gate-
way; not shown

Parts

Qty

S = N

A Replacement Danger and Warning labels, tags, and
cards are available at no cost.

Parts labeled n/a are not available separately.

NOTE: All brand names or marks are used for identifica-
tion purposes and are trademarks of their respective

owners.

312785D
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Parts
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Appendix A: DeviceNet™ Slave Communication

Appendix A: DeviceNet" Slave Communication

Overview

This appendix describes the Gateway’s support for
DeviceNet and details the configuration steps necessary
to use this feature. It does not provide a detailed
description of DeviceNet, but only a brief introduction,
necessary to define the terms that are used throughout
the remainder of this document.

Introduction

DeviceNet is a low-level network using the Controller
Area Network (CAN) technology, to provide communica-
tion between a range of industrial devices, from simple
devices such as sensors and actuators, to high-level
devices such as controllers and HMIs.

DeviceNet Port Protocols

The DeviceNet option card has one DeviceNet port. See
FiG. 31. The port may be configured for various Devi-
ceNet protocols. Contact Graco Technical Assistance
for currently supported protocols.

Also see Appendix A: DeviceNet' " Slave Communi-
cation on page 43.

DeviceNet Option Card Pin Outs

. V-
Position 1 of the pluggable connector provides a
CAN ground connection. This terminal is isolated
from the Graco Gateway.

e CAN_L
Position 2 of the pluggable connector provides the
CAN_L bus line (active low). This terminal is iso-
lated from the Graco Gateway.

« DRAIN (optional)
Position 3 of the pluggable connector is provided for
optional drain connections. This position is available
only to tie drain wires together or to earth ground.
There is no internal connection to earth ground. The
DRAIN position is not connected to any circuitry
internal to the DeviceNet option card.

312785D

CAN_H

Position 4 of the pluggable connector provides the
CAN_H bus line (active high). This terminal is iso-
lated from the Graco Gateway.

V+ (optional 24 Vdc)

Position 5 of the pluggable connector is provided for
optional 24 Vdc connections. This position is avail-
able only to tie 24 Vdc wires together. The Devi-
ceNet option card neither provides or uses 24 Vdc
power through this connection. The V+ position is
not connected to any circuitry internal to the Devi-
ceNet option card or Graco Gateway.
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Appendix A: DeviceNet™ Slave Communication

_l‘ E I‘
Z = Z 4
S U 6o u >
o
H o o o o o
1
[ I TI13963a
PLC Connection
[
o ] ; \ O
"
DeviceNet ” @ T@— ” 8888
Option Card D . ) ]
oL
o —
: -+
] | o000\ —
’ —— e |
@ TI13962a
FiG. 31: DeviceNet Port Pin Outs and PLC Connection
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About DeviceNet

DeviceNet is a connection-based network. In this con-
text the term connection refers to a communication path
between two or more devices, and not the physical
(cable) connection to the DeviceNet network. A connec-
tion must be established between two devices in order
to transfer data.

There are two types of connection defined by the Devi-
ceNet specification. Each has different characteristics
and is suited to a specific type of communication.

« |/O Connection — Dedicated data transfer between
a producer and one or more consumers. The format
of the data is known or implied by the connection.

* Explicit Messaging — Generic multi-purpose mes-
saging connection, typically command and
response message commands.

Each connection type has an extensive number of
parameters, which can affect the characteristics of the
communication path. For many Master/Slave communi-
cations scenarios, a defined set of connections, together
with their respective parameter settings exist under the
collective name Predefined Master/Slave Connection
Set. Many of the steps involved in creating and configur-
ing a connection have been removed with this connec-
tion set, thus simplifying the network configuration.

Predefined Master/Slave Connection Set

The DeviceNet specification details a number of con-
nections that facilitate data transfer between a Master
and Slave devices. The following sections detail the
connection types supported by the Gateway.

« |/O Bit-Strobe Connection: The Bit-Strobe connec-
tion is an 1/0O connection over which Bit-Strobe I/O
command and response messages are transferred.
The Bit-Strobe command is broadcast by the Master
device and is received by all slave devices simulta-
neously. The command message contains a single
bit of information for each slave on the network.
Each slave device is required to respond with a Bit-
Strobe response message. The response message
can contain up to 8 bytes of information.

312785D
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¢ 1/O Poll Connection: The Poll connection is an 1/0O

connection over which Poll command and response
messages are transferred. The Poll command is
transmitted by the master, and is directed to a single
slave device. The slave device in turn responds with
a Poll response message. Both the Poll command
and Poll response messages can contain any num-
ber of bytes.

e 1/O Data Connection: The I/O Data connection is
part of the Predefined Master/Slave Connection Set,
but instead is included for devices, which support
creating 1/0O data connections via the UCMM
(Unconnected Message Manager).

Level of Support

The Gateway provides Group 2 Server level support: A
UCMM capable device that is configured to act as a
Slave for the Predefined Master/Slave connection set.
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Appendix A: DeviceNet™ Slave Communication

Hardware

To use DeviceNet on the Gateway, an option card must
first be installed. The option card provides the hardware
necessary to support the CAN physical layer specifica-

tion as required by the DeviceNet standard.

Configuring the option card is a two-stage process; first
the option card must be selected in Gateway (DeviceNet
Option Card), and then the ‘DeviceNet Predefined
Group 2 Server Driver’ configured to run on the newly
created DeviceNet Interface port.

Gateway Configuration

The following example requires use of an Allen Bradley
1756-ControlLogix PLC, along with RSLogix 5000 and
RSNetWorx for DeviceNet software and a Gateway.

Configure the Gateway DeviceNet Option
Card

Install the Gateway DNOOOQO option card in the Gateway
as per the provided instructions.

Click on File>New to create a new Gateway database
and select Gateway Series HMI — Gateway 10.

Enter the Communications section. In the tree on the
left, select Gateway from the top of the tree. Select the
Edit button at the right, and select the DeviceNet Option

Card from the dialog box as shown in FIG. 32. Click OK.

Communications
=] psp
=) Programming Port
=1} R3-232 Comms Park
(== R5-485 Comms Port - Modbus Master
-0 ProMixzks
[=l-=A Ethernet
=% Pratocol 1 - Modbus TCPJTP Slave
(= I G306TCP
lE] Block 1 — Options
I Block 2

Option Card

~ Option Card Selection —

Option Card: | Mot Fitted

Hlock 3 Mot Fitted

Block 4 CAM Option Card
[+ ® Blocks
I 'E;' Protocol 2
I 'E;' Protocol 3
% Protocol 4
= % Services

El OPC Server

R5232/485 Option Card

FiG. 32: Select DeviceNet Option Card
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The DeviceNet Option card appears at the end of the
tree. Select the DeviceNet Interface from under the

DeviceNet Option Card item.

A X | O] 2|

eop 2KS_Gateway LE_OBO10B - Gateway LE - Graco Config

Appendix A: DeviceNet™ Slave Communication

On the right hand pane, click on the Edit button to open

the driver picker dialog box. Select the DeviceNet Pre-
defined Group 2 Server driver. FIG. 33.

Communications

=1 pse
=) Programming Port
=) RS-232 Comms Part

[ ProMixzks
=& Ethernet

G306TCP
| EBlock 1
Elock 2
Elock 3
Elock 4
# Elock 5
W Protocol 2
W Protocol 3
% Protocol 4
By Services
I opc Server
[=-<#® DeviceMet Option Card
=) DeviceMet Interface

=~

=

(==} R5-455 Comms Port - Modbus Master

% Protocol 1 - Modbus TCRIIP Slave

1~ Driver Selection

Driver: I Mo Driver Selecked

~Part Settings

Batd Rate: | 125000 vI

Driver Picker for DeviceMet Port

~Manufacturer

i~ Driver

Mo Driver Selected
Predefined Group 2 Serve

s
oK I Cancel | Help |

FiG. 33: Select DeviceNet Server

Set the appropriate Station Address, Bau

d Rate, and I/O

Poll Size. Make sure the Data Format Settings are set to

Transform: Swap Bytes In Word. FIG. 34.

312785D
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Appendix A: DeviceNet™ Slave Communication

IMPORTANT NOTE: The I/O Polled Size is determined
by the settings in both the DeviceNet Master and the
registered .EDS file for the Gateway. To change these
settings, see Automatic Update of the EDS File on

page 52 before setting up the PLC.

427 2KS_Gateway LE_0B0108B - Gateway LE - Graco Config
File Edit “iew Link Help

D@ d|ssb@EXx|0O| 2|

Communications

DsP
-={l Programming Port
-=fl) R5-232 Comms Port
-=]) R5-485 Comms Port - Modbus Master
M0 ProMixZks
=& Ethernet
Protocol 1 - Modbus TCRJIP Slave

[+ ® Blocks
W Protocol 2

Protocol 3

Protocol 4

% Services

- I oRc Server
=<2 DeviceMet Option Card
==} DevireMet Tnketfare - Group 2 Server

FIG. 34: Device Settings

—Driver Selection

Driver: I DeviceMet Predefined Group 2 Server Edit... |

~ Device Settings

Node Address: 1 Data Format: | ERE N

~—Data Transfer Settings
Enable

Cormmand Respanse

1o strabed: o

I/0 Polled: IVes

1j0 Data: [ 1

—Electronic Data Sheet

Synchronise:  |Mo

Filename: I

EBrowse. ..

~Port Settings

Baud Rate: | 125000 -

Clear Part Settings

Add additional Device
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Appendix A: DeviceNet™ Slave Communication

Create Gateway Blocks

Select the DeviceNet device from the tree at the left,
and add two Gateway Blocks; one for Read Data and
one for Write Data, using the Add Gateway Block button

on the right hand pane.

27 7KS_Gateway LE_0BO108 - Gateway LE - Graco Config
File Edit Wiew Link Help

=gy =]

Communications =]
=14 pse Device Settings

=0 Programming Park
=) R5-232 Comims Port [ Enable Device r ’—

== R3-485 Comms Port - Modbus Master
I Profixzks
—|-=d= Ethernet
=% Protocol 1 - Modbus TCRJIP Slave
=M GI06TCP
+- W Block 1
+- W Blockz
+- W Block 3
+- W Block 4
+- W Blocks
W Protocol 2
W Protocol 3
W Protocol 4
-4y services
T orC server
—|-<# DeviceMet Option Card
== DeviceMst Interface - Group 2 Server
= m [l

m Elock 1

Delete This Device Add Gate}v\ay Block |
My

Fic. 35: Add a Gateway Block

Select the first Gateway Block and select the Edit button

at the right.

Set the block for 1/0 Polled Command Data, starting at
element PollC 00000. FiG. 36.
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Appendix A: DeviceNet™ Slave Communication

NOTE: For 16-bit support, select Word as Word. For
32-bit support, select Word as Long. The latter is recom-
mended as DeviceNet uses 32 bits integer addressing.

Set the block size for 4, and the Direction for: Device To

Gateway. This will be the Read Data block.

427 2KS_Gateway LE_0BO10B - Gateway LE - Graco Config

File  Edit  View Link

- [Ex]

=y =

Communications

= [ Dsp
= Programming Port
=l RS-232 Comms Port
== R5-485 Comms Port - Modbus Master
M ProMicEKs
==& Ethernet
=% pratocal 1 - Madbus TCR(IP Slave
i 0 G306TCP

i i+ W Blocks
B Protocol 2
B Protocol 3
- E Protocol 4
=] % Services
Iy OPC server
=% Devicelet Option Card
I=1-=] DeviceMet Interface - Group 2 Server
= DEVI
W Block1
M Blockz

/% @ X |0 |

1~ Black Settings

Start Address: | None

Block Size! | o

e

Direction: | 53 to'Device

Select Address for Group 2 Server

Edit..,
Edit. .

X

— Element

PallC | onoag LONG

—Data Item
<Monex Mo Selection
Bite I} Bit Strobe Carmmand Data
BitR. /0 Bit Strobe Response Data

1/ Polled Command Data

Pollr. I} Polled Response Data
oC Ij0 Consumed Data
IOP I} Produced Data

~Data Tvpe

IWord a5 ‘Word

~ Details
Type: Waord
TMlinimuUm: PollCO0000,LONG
Maimum: Poll 65535, LONG
Radix: Decimal

(64 I Cancel Help

FIG. 36: Select Data Type (Word as Long)
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Appendix A: DeviceNet™ Slave Communication

Select the second Gateway Block and set it up for /0
Polled Response Data 00000, with a length of 4, and the
Direction Gateway To Device. This will be the Write
Data Block. FiG. 37 shows both Gateway blocks once
completed.

437 7KS_Gateway LE_0BO108 - Gateway LE - Graco Config
File Edit Wiew Link Help

Oe &

Communications
=4 osp

=) Programming Port
=) R5-232 Comms Port Start Address: | PaollCO0000.LONG

== R5-485 Comms Part - Modbus Master

I ProMix2ks

—|-=d= Ethernet

=% Protocal 1 - Modbus TCPJIP Slave

=-I GI0ETCP
+-m Block 1 Block Control

m Block 2 |
m Block 3

m Block 4 |
+- W BlockS

¥ Protocol 2 %

'3' Protocol 3 Export to File. .. | Delete This Block ‘iew Block. . ‘
B Protocol 4
= % Services
m CPC Server
=)< DeviceNet Option Card
=1-=) DeviceMet Interface - Group 2 Server
= DE1
—-m Block 1
¥ PollCo0000,LONG
¥ Pollcoo00z LONG
¥ Pollco0004 LONG
¥ PollCo0006 LONG
=-m Block2
¥ PollCo0000,LONG
¥ Pollcoo00z LONG
¥ Pollco0004 LONG
¥ PollCo0006 LONG

Fic. 37: DeviceNet Block Mapping

Elack Settings

Block Size: | 4

Direction: | G3 to Device

EIEIE

EIE

NOTE: Read and Write are from the Gateway point of DataP — Identifies the 1/0O Produced Data (Slave to Mas-
view. This means the master can send data in Block A, ter).

so the Gateway can read data. On the other hand, the

master can only pull data from Block B, so the Gateway

can only write data.

The addressing scheme available is outlined below:

BitC — Identifies the 1/0O Bit-Strobe command data (Mas-
ter to Slave).

BitR — Identifies the 1/O Bit-Strobe response data (Slave
to Master).

PolIC — Identifies the I/O Poll command data (Master to
Slave).

PolIR — Identifies the 1/0O Poll response data (Slave to
Master).

DataC — Identifies the 1/0O Consumed Data (Master to
Slave).
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Appendix A: DeviceNet™ Slave Communication

Automatic Update of the EDS File

DeviceNet nodes use an EDS (Electronic Data Sheet) to
describe the communications parameters available at
each device on the DeviceNet network.

By design, each DeviceNet master can handle a maxi-
mum of 124 Input words and 123 Output words. In the
default EDS file for the Gateway, the Input and Output
data sizes are set at 16 bytes each. This equates to four
words of data input and four words of data output.
These values can be set higher, but it is important to
note that if the default values are set higher, they might
conflict with other DeviceNet implementations.

427 2KS_Gateway LE_0BO108 - Gateway LE - Graco Config
File Edt “ew Link Help

Ow &

munications
=il oep
=l Programming Port
=) RS-232 Comms Part
==l RS-485 Comms Port - Madbus Master

=)=l DeviceMet Interface - Group 2 Server
=-H DEW1

=M Block 1
¥ PoliC00000.LONG
¥ PoliCO0002.LOMG
¥ PoliC00004.LONG
¥ PoliC00006.LONG

—-m Block 2
¥ PoliC00000.LONG

Driver Selection

Gateway provides an EDS file generator tool to create a
file that matches your Gateway settings. This file can
therefore be used to configure the Master.

To generate this file, enter the Communications module
and select the DeviceNet interface on the left. Under the
Electronic Data Sheet, select Yes in Synchronize and
choose the path and name where the file should be
saved using the Browse button. FIG. 38.

Drriver: |DeviceNet Predefined Group 2 Server Edi...

H Prafixzks Device Settings
==& Ethernet
=% Protocol 1 - Madbus TCPJIP Slave Made Address: ! Data Format: |Swap Bytes in Waord j
=10 G306TCP
+- W Block 1 Data Transfer Setkings
+- B Block 2 Enable Command Response
+- W Block3
- ® Block 4 I} Skrobed: |No j | |
+- W BlockS
W Protocol 2 LjC Polled: |\"ES j | 16 | 16
W Protocol 3
IiC Data:
W Protocol 4 / |ND j | |
= % Services
m OPC Server Electronic Data Sheet
=% Devicelet Option Card Synchronise: [ves -

Filename: | ents and Settings\quwriliGateway|Devicellet interface. eds

Part Settings

Baud Rate: | 125000 -

Clear Port Settings ‘

¥ PallC00002.LONG
¥ PallC00004.LONG
¥ PallC00006.LONG

Close |

Fic. 38: Automatic EDS Update

Saving the database using the File>Save command will
synchronize and therefore update the EDS file.

Each time EDS parameters are modified, the EDS file
will need to be re-registered within RSNetWorx for Devi-
ceNet. These changes will also need to be reflected in
the following locations:

 RSNetWorx master node Scanlist, Input Table, and
Output Table

» ControlLogix PLC DeviceNet Scanner configuration

52

NOTE: Inputs and Outputs are with respect to the mas-
ter, therefore inputs refer to data sent from the slave and
read by the master.
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Appendix A: DeviceNet™ Slave Communication

Configure the RSNetWorx for DeviceNet Software

RSNetWorx for DeviceNet is used to set up and manage
a DeviceNet network. To begin the configuration, launch
RSNetWorx for DeviceNet from your development PC.

Start a new network by selecting: File>New>DeviceNet
Configuration.

Register the EDS file generated by Gateway as shown
in the previous section of this document by selecting:
Tools>EDS Wizard>Register an EDS file(s).

Rockwell Software’s EDS Wizard N

Options
Wwhat tazk do you want to complete?

= Register an ED'S filels].
Thiz option will add a device[s] to our databaze.

" Unregister a device.
Thiz option will remove a device that has been registered by an EDS file fram
our database.

£~ Change a device's araphic image.
| Thiz option allows vou to replace the graphic image [icon file] associated with &
device.

" Create an EDS file.
Thiz option creates a new EDS file that allows our software to recognize pour
device.

€ Upload EDS filsfs] from the device,
Tihiz aption uploads and registers the EDS filelz] stored in the device,

< Back I Mext » I Cancel

FiG. 39: Register the EDS File

Select Register a single file, and browse to the location
where you saved the Gateway.EDS file.

Rockwell Software’s EDS Wizard o

Registration
Electionic Data Sheet file(z) will be added to vour spstem for uze in Rockwel
Software applications.

' Register a single file
£~ Register a directory of EDS files IT | Lookitisubfolders
Mamed:

C:ADocuments and Settings\Desklop\EDS Fileshg3d.eds

Browse... I

*If there is an icon file [Lica] with the zame name as the file(s) you are registering
then this image will be associated with the device

Ta perform an installation test on the file[s], click Next

< Back | Mest > | Cancel

FiG. 40: Browse to Graco Gateway EDS File

312785D

Make sure that the .EDS file validation is successful.

Rockwell Software's EDS Wizard

EDS File Installation Test Besults
This test evaluates each EDS file for erors in the EDS file. This test does not
guarantes EDS file walidity.

EI--JEI Installation Test Results
. E! chdocuments and zeftingsdesktopteds fileshg3 eds

Wi file...

< Back I Mexst > I Cancel

Fic. 41: EDS Validation

If desired, select a new image file to represent the Gate-
way.

Rockwell Software's EDS Wizard .

Change Graphic Image
fou can change the graphic image that is associated with a device.

Product Types

E@ Generic Device
i G3SERVER

Change icaon... |

< Back I Mest > I Cancel

FIG. 42: EDS Image File
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Review the EDS registration, and finish the process.

Rockwell Software's EDS Wizard X

Final Taszk Summary
Thiz iz a review of the task you want to complete.

B™v'ou would like to register the following device.
G3-SERVER

< Back I Mext » I

Cancel

FIG. 43: Review EDS Registration

2|
General| Moduls Scankst | Input | Output| ADR | Summary|
Available Devices: Scanfist:
[ 01. G3SERVER
2l
=
=]
&l
¥ Automap on Add v Node Active
Upload from Scanner... I l EF-CHWTW
¥ Vendar
Download to Scanner... v Elml Code
EGUI/0 Paremeters.._| ,':,., S
0K | Concel | Apph | Hep

Edit 1/0 Parameters : 01, G3-SERVER 21X
1 Shobed: 1 I Change of State / Cychc
Input Size: |'-' _I:[ Bytes ! Ciey
Input Size: |"' _|:| Bytes
¥ Polled — = Output Size: |':' _|: Bytes
InputSze:  [16 = pyres e
Dutput Size: I‘IB a. Bytes
|
Poll Rate: IEvery Scan 'I |
[ ok ] cacel | Restoel0Sizes |

Select the DeviceNet Master by navigating in the tree on
the left hand side. Navigate to: DeviceNet>Cate-
gory>Communication Adapter>1756-DNB/A. Select the
appropriate Major Rev and drag it into the network work-
space at the right.

Select the Gateway Slave by navigating in the tree on
the left. Navigate to: DeviceNet>Vendor>Graco Con-
trols>Generic Device. Select the Gateway-SERVER
and drag it into the network workspace at the right.

Configure the master to add the slave device to the
scanlist. Right click the DNB module and select proper-
ties.

From the Scanlist tab, select the Gateway-SERVER
from the Available Devices pane, and add it to the Scan-

list pane. Select the Edit I/O Parameters button.

FiG. 44: Configure the DeviceNet Master
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Make sure that the Strobed or Change of State boxes
are not selected. In the Polled section, verify that the

Input and Output sizes are 16 bytes. These must match
the 1/0O Poll Size selections made above in the Gateway.

In DeviceNet networks, 4 bytes constitute a full word.

Therefore the 16 bytes selection represents 4 full words

of addressable 32-bit data.

Genelall Mudulel Scanlist  Input IUutpulI ADR | Summawl

Lutatdap

Unmap |
Advanced... |

7 I _’I DOptions... I

Memory: | Assembly Data 'I Start Dword: |0 __J:
Bit531-0| IIIIIIIIII o

21.Datal0r
21.Datall
21.Data
2 1.Datald

Polled 16 21.Data[0].0

21x]

Appendix A: DeviceNet™ Slave Communication

Select the Input tab. Verify that the four words of Gate-

way-SERVER data are mapped to YourD-

NBSlot:I.Data[0...3]. From the Output tab, verify that the
four words are mapped to YourDNBSIot:O.Data[0...3].

Apply the changes, and save your RSNetWorx for Devi-

ceNet configuration.

. 1756-DNB/A 2| x|

General | Module | Seanlist| nput Dutput |DF| | Summa |
lethan
Unmap

Advanced

i I I _’I DOptions..

Memary: |AssemblyData j Start D'word |D ::‘l

oled 16 20.Datal0l0

.Dal
2:0.Diatald

oK I Cancel Apply I Help

Ok I Cancel Spply I Help

Fic. 45: Apply and Save
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Appendix A: DeviceNet™ Slave Communication

Configure the Allen Bradley ControlLogix PLC

Allen Bradley ControlLogix PLCs are programmed with Create a ControlLogix program containing a valid Devi-
RSLogix 5000 programming software. To begin the ceNet Scanner. In this application a 1756-DNB was
DeviceNet configuration, launch RSLogix 5000 from used.

your development PC.

=[alx]

% RSLogix 5000 - Devicenet [1756-L55]
Fie “Edit Yiew Search Logic Communications Tools Window Help

Mo Forces
Mo Edits

=145 Controller Devicehiet

[ controller Tags
++[71 Controller Fault Handler
[ Power-Up Handler
(=3 Tasks
B3 MainTask

=I-£8 MainFrogram
[ Program Tags 0 Ml Module Propert 2 (1756-DNB 3.5)

H - MainRautine
[ Unscheduled Programs
1=} 5 Mokfon Groups Type: 1756-DNE 1756 DevicsNe! Scanner

[ Ungrouped Azes
~ Trends

&5 Data Types Hane: DevicelNet Input Size:

123 =
L User-Defined =
#[3 strings Diescription - Output Size 123 _,::j [32:bit)
)
S

(32:bit)

General | Connestion | ASNetwons | Module Info | Backplans |

Wendor: AllenBradiey
[32-bit)

Stafus Size:

539 Module-Defined |
[JO Configuration
-89 1756 Backplane, 1756-4)
% [0] 1756-L55 Device Node: 0 = st P o
B § [1] 1756-ENET/AETI
g Ethemet Bevision: 3 =€l 3: Electronic Keing: | Compatible Keying -
] [2]1756-DME Device

Status: Offline

FillFie

—r
1 Module Defined Tags
[3 Locatzi
-1 Locarzo
A Locatzs = .
| f » | » [\MainRoutine
Ready

FiG. 46: Create Valid DeviceNet Scanner
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Configure the DeviceNet Scanner to be address 0.
Make sure to set up the 32-bit Input and Output memory
spaces for a size of 32 (to match the configuration made

above in both Gateway and RSNetWorx for DeviceNet).

# RSLogix 5000 - DeviceNet [1756-L55]

Appendix A: DeviceNet™ Slave Communication

Select the RSNetWorx tab, and navigate to the RSNet-
Worx for DeviceNet configuration that you have previ-
ously created. Open the configuration from here and
download it to the network.

=]

File | Bdt Wew Search Logic Communications Tooks Window Help
IF e T S — Y - e

Dffline 0. I AuM e Im Pl [BE_ETRT72 26 B0 Basiplanetd v |§5j

No Farces r. FSL(T @ |
e s | {wh | ¥
Mo Edts 2 Wi _I I l __I | i | _]

e ’ 0.8

=5 Contraller Devicehiet =10i =]

[ controller Tags
[ Controller Faulk Handler

(23 Power-Up Handler

Tasks

| E-AE MainTask
123 MainProgram

A program Tags

... mainRoutine

] (53 Unscheduled Programs

125 Mation Groups

(53 Ungrouped Axes

Trends

Data Types

s, User-Defined

adule Prop:

General | Connection §

F5ii)| Module Info | Backplane |

Shrings
Predefined Foundin <Flle rot founds>
1y, Morhle-Defined - Launch RENefWor: for Devicel

DeviceNet File (.dnt) ﬁUU\Tech Notes\DeviceMet Configuration (T589231DeviceNet dnt Browse

140 Configuration
B 1756 Backplane, 1756-4|
{0 [0] 1756-L55 Devire:
2§ [1]1756-EMBTIAET|
g Ethernet

ﬁ% Yiew and edit the DevicaNat netwark

f) [21 1756-DNB Device

Status: Offfine

Cancel

Ei——
1 Module Defined Tags =
-3 Localz
L Localzo
L3 Locprzs Z
4 r » 4| ¥ [\ MainRoutine

Ready

FiG. 47: Main Task Tree

In the Main Task tree, open the Main Routine Ladder
Logic file. Create a rung of ladder to enable the Devi-
ceNet network. The required output is always:
Local:YourDNBSIlot:0.CommandRegister.Run

Create a few rungs by taking the DeviceNet Input data,
Local:2:1.Data[0...3], and adding 1 to them. Store the
results in Local:2:0.Data[0...3]. Based on the configura-
tion in the Gateway, if values are changed on the Gate-
way Write tags, the Read tags will display the respective
values, plus one.

Save and download this configuration to the Control-
Logix PLC.

312785D

Wire the DeviceNet Network

All DeviceNet networks require a termination resistor at
the two end nodes on the network. Place a ¥ watt 120
ohm resistor between CAN H (White) and CAN L (Blue)
of the DeviceNet connection.
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Appendix B: Profibus' DP Slave Communication

Overview

This appendix describes the Gateway’s support for Pro-
fibus DP and details the configuration steps necessary
to set up a Graco Gateway with an S7300 PLC,
CPU315-2DP via Profibus. It does not provide a
detailed description of Profibus, but only a brief introduc-
tion, necessary to define the terms that are used
throughout the remainder of this document.

Introduction

Profibus DP stands for “Profibus for Decentralized
Peripherals”. Profibus DP is a device level bus that sup-
ports both analog and discrete signals. It has wide-
spread usage for such items as remote I/O systems,
motor control centers, and variable speed drives. Profi-
bus DP communicates at speeds from 9.6 Kbps to 12
Mbps over distances from 100 to 1,200 meters.

The protocol supported by the Profibus DP option card
is Profibus DP Slave. Therefore, the Graco Gateway
must be linked to a Profibus network with a PLC.

Profibus Port Protocols

The Profibus option card has one Profibus port. See
FiG. 48.

Also see Appendix B: Profibus™ DP Slave Communi-
cation on page 58.

Profibus Option
Card

PLC Connection O
[e]e)e]e)
OOOO| —
g
gi )
coool=

TI13964a

FiG. 48: Profibus PLC Connection
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About Profibus DP

Profibus DP communication takes the form of block
exchange. Profibus blocks are made of memory bytes
where 2 bytes make a word and 4 bytes a double word,
or Dword.

A block is a range of consecutive byte addresses and is
unidirectional. This means the PLC will exchange data
read only and write only blocks with DP slave units.
Addresses in each device are independent and only rel-
evant to the device for its own program. For example,
the address range for the first block in the master can
start at 256 with a 64 words block length and could
result in the slave with a range starting from 0 with 64
words length.

However, since blocks are consecutive, this means the
first block start address, in the above example 256, will
be the slave start address 0. Then, 257 in the master
would be 1 in the slave, and so on.

Appendix B: Profibus™ DP Slave Communication

Block length can be defined in bytes, words, or double
words. Since start addresses between the master and
the slave can be different, one could give its start
address and length in bytes, and the other in words.

For example, the master start address is byte 256, with
a 64 words block length.

e This results in a range from byte 256 up to byte 383.
The slave start address is word 0, with a 64 words
block length.

e This results in a range from word 0 to word 63. FIG.
49 illustrates this exchange.

NOTE: Do not forget that the Input block is independent
from the Output block, and although the address range
is the same, the data are different.

NOTE: FIG. 49 has no connection with the Input Block
and Output Block in Graco Gateway. The terminology
used in the tags configuration is from the PLC point of
view (DP Master). Refer to Graco Gateway Setup for
more information.

DP Master DP Slave
Output Block Input Block
byte 256 to byte 383 [ ™| word 0 to word 63

Input Block Output Block
byte 256 to byte 383 [ word 0 to word 63

FiG. 49: Master/Slave Exchange

312785D
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Appendix B: Profibus™ DP Slave Communication

Setup the PLC

The Siemens Simatic Manager software is used to set
up the S7300 PLC. The following figures and explana-
tions are extracted from this software.

Install the GSD file

The first step is to install the GSD file so Simatic is able
to map data blocks to our device. Contact Graco Techni-
cal Assistance for Profibus GSD files.

Start Simatic Manager and open or create a new PLC
project. Select the Simatic 300 Station in the navigation
pane as shown in FIG. 50.

Fd STnTag Manager - 5T Pro2 =151 =

Fla Edt “oBart PLC Waw Opdons  Wndow  Help

QIEIE!IEI.#L_IEIEINI_EI_FZI_I_IIWDHW ~1%) e BE
s Program Fns)\ Step T sTprot S T_ProZ =100 =]

CRUIG.20P] [::E

=+{E&) 57 Frogian{1|
(] Souicas
(g Blocks

B 5 57_Fro? i Haidwara IEPLI:HEED Pt

Friss Fi ba gat Hedp,

| PC Adapter(MFI) o

FiG. 50: Select Simatic 300 Station

Double-click Hardware in the right hand window. This
will start the HWConfig where most of the work is done.
The HWConfig shows the current PLC hardware config-
uration. Close this configuration (NOT HWConfig) and
FiG. 51.

choose Options>Install GSD File...

Fic. 51: Install the GSD File

PROARLS =
FRONBLE P
FROAKET I
5l TMATE S
- SHATIC 410
- ! SHATICPC § siad Condod 10080

SMETICPE fisios
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Click Browse to select the folder were the GSD file
downloaded previously is, select the file and click Install.
FiG. 52.

Install G5 Filas

Appendix B: Profibus™ DP Slave Communication

Once the GSD file is installed successfully, the PLC
hardware setup can be opened again by doing Station
and selecting the latest opened file which should be
number 1.

If this is a new project, configure your PLC with the right
modules.

Install G50 Files:

frorn e drecton

U:ADocumentst_HMI_G3sDiiver\Profbus

Biowse ...

D etaul

GAMC/DSP Prchbus Card [R2PE 0000ACF20000]

Shioww Log

Select Al

Dezelect Al

Install 'D@J

Hep

FiGc. 52: Browse to GSD File
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Appendix B: Profibus™ DP Slave Communication

Setup the Profibus Network

The following steps show how to set up the Profibus DP
network. Skip these steps if your PLC application
already possesses a Profibus DP network.

ILT|SPATIC 300 Statios (Cenfiguration) — §7_ProZ

Eb

In the floating window that represents the PLC, double
click the DP area to open the properties window as
shown in FIG. 53.

-

1 F5 20758 -
] CPLIA 5-20P[0
3
¥ | DIeA0aociaes
5
i
: =]
5
1 ] [}
4= =0 Uk
Slok Madue lirdmnu'rbﬂ' Fimwars | WP addwss | | addese | O acdiess | Commen |
I EE EES7 207-1 EADCHOSAT
z CPUME-20F[1) BES7 2IE-ZAGID-OARD (V2.0 2
=l s T
3
4| DEDDBDCAISS [EES? 321 BHO -W0AD 0 0
5
B
7
A
3
10
il

FIiG. 53: DP Properties Window
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Appendix B: Profibus™ DP Slave Communication

In the General tab, click the properties button to open
the Profibus properties. FIG. 54.

PFrepertics - DF - (ROVSZ.1) x|
Bl | fcdieees | Cpmating Mods | Confiorsion |
Ghak Dazanphor: K12
=]
=
Dider Ho:
Mawe H
Irde s e
Trp= PROFBUS
diddiess 2
Matantiad by Prapifiic: .. t:I
Connrrant:
=
=
e ||
FIG. 54: Open Profibus Properties
In the properties window, go to the Parameters tab and
click on the New button to create a new network. FIG.
55.
Froperties - FROFIOUS imterface DFP (RO/S2,1F _J_t_l
Geneal F'-:llrr-abﬂrl
Adess EZ -
S bl
timn ]
Riremer, I
ox, e

Fic. 55: Create a New Profibus Network
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Appendix B: Profibus™ DP Slave Communication

Select the Network Settings tab and choose the Trans-
mission Rate that fits the application. In this example, it
will be 12 Mbps. The profile should be DP. FIG. 56.

Froperties - e subnet FROFIDUS . |

Ganeal | Meowork Getlings |

E Options...
Higkael FROFIBUS
Addmz I 25 ¥ [ Dranga
Trarsmazson Aate S00 Kbps :I

Profik:

FiG. 56: Set Transmission Rate

Close the popup windows by clicking OK. HWConfig
should now show the Profibus DP master system next to
the PLC. FIG. 57.

g:-" PS 207 54 -

CPU315-2DP(1])

—_

a8
PROFIBUS: DF master system (1]
DIZ/D0OBDC2V AT

qmmhwagm

=l

FiG. 57: Profibus DP Master System
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Appendix B: Profibus™ DP Slave Communication

Add the Graco Gateway to the Profibus Network

To add the Graco Gateway to the Profibus network, In the properties window that popped up, select the Pro-
drag the Gateway Profibus Card from the Catalog navi- fibus address the Gateway will take on the network. This
gation situated on the right hand side of HWConfig to address should be unique. In this example, the Gateway
the Profibus DP Master System. The card is situated will take address 5. FIG. 58. Click OK.

under Profibus DP>Additional Field Devices>MMI.

n

TITTTITTTT T IR

Fic. 58: Add Graco Gateway to Profibus Network
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Appendix B: Profibus™ DP Slave Communication

The Gateway is now on the Profibus DP network and
selected. HWConfig shows the slots available under the
Gateway to configure the data blocks to exchange.

Just drag and drop one of the data blocks available
under the Gateway Profibus Card in the slot number 1.
Simatic will automatically assign a start address (byte
number) in the respective Input and output columns
depending of the block type chosen. In this example, 64
words in and 64 words out.

Seza Bk bems R Ve Ophaw Wk el

Diz|i-S & &) bie| ] 2 el

FRLFELE OF ram a1 |

Ir T

More blocks can be inserted in the following slots to fit
your application. FIG. 59 shows an example with a 16
words input block in slot 2 and 5 words output block in
slot 3. Addresses are given automatically but can be
edited by the user.

NOTE: If the starting address for a block in slot 2 or
above changes and creates a gap in the address range,
it will not affect the Gateway blocks, as all data are con-
secutive. It is however advised to keep the addresses
consecutive to facilitate development.

- L =
3 O hiddienad Thidd Dawin
0 1M

L vn

& ) BMAEE Pt
Urrasezal rcduls

v O, G

haoacs Tl B
G sleach Chi Eialn
T %oad 0 1k, 1 Wiard
TEwerd b
Ailwoadin
I tocachi|n
1Ewerdke ok
S'wioadk
Ttoads il
RIS Fuobus L—
Froloce [21 PFESLL Y

£ 15 Hatwasy
43 Cowpaibls FRCOFIELS D9
T CATbad

L Clisc, oo Dt

() Cosigua Bleors

RS R i

B Dy orany

i [ DP#F.Link

FiG. 59: Configure Data Blocks

Save the configuration and download it to the PLC.

NOTE:
¢ The maximum number of input bytes allowed is
244,
¢ The maximum number of output bytes allowed
is 244.

¢ The maximum number of bytes overall is 436.
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Graco Gateway Setup

Once the PLC is setup, the Gateway can be pro-
grammed to fit its configuration.

Appendix B: Profibus™ DP Slave Communication

NOTE: For a Gateway to communicate on Profibus DP,
a Profibus Option card has to be fitted in the unit. Refer
to the device manual to find the proper option card and
installation procedure.

Setup the Profibus Communication

Enter the communication module and select the Gate-
way. On the right hand pane, click the Edit button to
select the Option card. Select Profibus Option card and
click OK. FiG. 60.

=) Programming Port

=) R5-232 Comms Port

=) R5-455 Comms Part - Modbus Master
- HI ProMixzKs

=4 Ethernet

- Protocal 1 - Madbus TCR{IP Slave
- G30ETCP

W Elockz
W Elock3
W Elock4
B Blocks
"% Protocol 2
"% Protocol 3
: "% Protocol 4
& % Services
: m OPC Server
=<2 Profibus Option Card
=] Profibus Interface

FIG. 60: Select Profibus Option Card

— Dption Card Selection

COption Card: ] Profibus Option Card

Option Card

Remove Option Card

X

~ Qptions

Mok Fitted

RS232/485 Option Card
AN Option Card
Profibus Option Card
Devicelet Option Card
DL Option Card

Cancel |
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Appendix B: Profibus™ DP Slave Communication

The option card appeared in the communication tree.
Select the Profibus Interface and click the Edit button to
select a driver. Click OK to pick the Profibus DP driver.

FiG. 61.

nk Help

42 IKS_Gateway LE_0BO108 - Gateway LE - Graco Config

Communications

= I3 pse
=) Programming Part
o) RS-232 Comms Port
(== RS-455 Comms Port - Modbus Master
[ ProMixzks
Ethernet

1~ Driver Selection

Ditivver l Mo Driver Selected

I~ Manufacturer

- ® Blocks
W Protocol 2
- E Protocol 3
o E Protocol 4
=] % Services
I opc server
[=|-<#® Profibus Option Card
=) Prafibus Interface

-Driver

No Driver Selected

O, l Cancel I Help I

FiG. 61: Select Profibus Server

Graco Gateway now displays the driver settings where NOTE: There are no Baud Rate settings as the Profibus
the Station Address can be changed. This address is option card detects the transmission rate automatically.
the Gateway address on the Profibus network. In our

example, this address is 5 as setup in the PLC earlier. A device called PLC1 is now displayed under the Profi-
bus Interface. This device represents the Profibus Mas-
ter and can be renamed to fit the application. In this
example, the name PLC1 remains. FIG. 62.

&2 7KS_Gateway LE_0BO108 - Gateway LE - Graco Config

File Edit ¥iew Link Help

D d|7sbmX|O]s|

Communications

DsP

=1 Programming Park
) R5-232 Comms Port

=) RS-485 Comms Port - Modbus Master
~ I ProMix2ks

=& Ethernet

Protocol 1 - Modbus TCPYIP Slave
= GI0STCP

W Protocol 2

El-% Jervices
IR opC Server
[=]-<#¥ Profibus Option Card
E-UII Profibus Interface - Profibus DP
=-m

FiG. 62: Block Settings

~Block Settings

Start Address: I Mone

Block Size: | o Edit... |
Direction; [23to pevice Edit.., |

—Block Contral

Request: * General I Mone Edit... |
Acknowledge:  w General I Mone Edit... |

Export to File,. ., | Delete This Block igw Block,. . |
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Appendix B: Profibus™ DP Slave Communication

Setup Tags First, create a variable that correspond to the data type

L required. In this example, an integer. FIG. 63.
Once the communication is set up, tags can be created

to access the PLC blocks. This is where the section
Setup the Profibus Communication, page 67, is
important.

a7 PKS Gateway LE 080108 - Gateway LE - Graco Config

Viegw Lok He

Ded|Z4tb@EX|oO| 2|

Communications

=1 pse 1~ Block Settings
=) Programming Port |
=l R5-232 Camms Port
== R5-485 Comms Port - Modbus Master
I ProbixKs

T Profi agList

[=]- =& Ethernet b
i ¥ Protocol 1 - Modbus TCRYIP Slave ~= Tags Edit., |
=0 G3I0ATCP
[+ W Block 1
Block 2 S |
Block 3
[+ ® Block 4 =
-8 BlockS
¥ Protocol 2
¥ Protocol 3 & Thic Block View Bleeke. |
i ¥ Protocol 4
EI-% Services
- m OPC Server
[=-<#® Profibus Option Card Sort Tags by: I""Fl'?'l"i! Crrder d
= =) Profibus Tnterfare - Profitus DR
E]m FLCL ~Create Tag
~-® Block 1

‘. m Block? b @Irteoer Variable Create. .. |
Ok | Cancel |

Select Tag

Fic. 63: Create a Variable

Select the variable and rename it eventually. Then, click
on Internal next to mapping on the right hand side pane,
and select PLC1, which is the Profibus Master. FIG. 64.

=] Programrming Pork
=] R5-232 Camms Part

(B\ock Settings

: S-elect Tag \ind =i
427 Properties of Variable1 _ — Select PLC1 from

<A Ethernet
N W Protocal 1 - Madbus TCR{IP Sl pu||d0Wﬂ menu

Data I

~Wariable Data

Mapping:

Sign Mods: [Driver Defaul

Lel Ll

IP& ad and \Write

'3‘ Pratocol 4 Storage: INnn-Ratentive Vi

Services

'il OPC Server ~Information
1< Profibus Option Card

=) Profibus Interface - Profibus Dl
=M PLCY

- m Block1
L. m Block2 Cancel

FiG. 64: Variable Properties

Comment: I
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In the popup window, select the block type required.
Two choices are available:

e Input block: The terminology input is from the Sie-
mens perspective. Therefore this will be a block the
Gateway will write to. The tag mapped to an input
block has to be set up as Write Only.

e Output block: The terminology output is from the
Siemens perspective. Therefore this will be a block
the Gateway will read from. The tag mapped to an
output block has to be set up as Read Only.

42F Properties of Variable1

Data l

Yariable Data

* Select the data offset, which points the address to

read or write in the block. Select the data type to
read or write. This defines how many bytes to
access in the block to get the correct data. In this
example we choose output block, with data offset
0 (Which points to 256 in the PLC) and as a Word.
FIG. 65.

Select Address for, Profibus DP E'

aka Block.
lock Type npuk Block
Data Offset anan
Data Tvpe |Ei~,.fte -

o]

FiG. 65: Select Block Type

Cancel | Help |

NOTE: Since the output block is a reading block from
the Gateway standpoint, this variable should be set up
as Read Only as shown in Fig. 19. The same rule
applies if the block is an input block, it should be set up
as Write Only.

To avoid mistakes, the mapping shows with an R or W
for output or input block respectively. FIG. 66.

Mapping: ¥ PLC1 | WO000,BYTE

ACCess; |F{ea|:| Cnly
Information

Comment: |

(0] 4 | Cancel |

FIG. 66: Properties of Variable
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How Addressing Works

Appendix B: Profibus™ DP Slave Communication

The Gateway addressing follows a different scheme, as
shown in FIG. 68.

PLC addressing is in byte and uses the scheme shown
in FiG. 67.

Byte O
Byte 1
Byte 2

Byte 3

Byte 4

Byte 5

Byte 6

Byte 7

Word 8

Note how a Dword or word address starts at the

address of the first byte included in it.

Fic. 67.

PLC Addressing Scheme

This means that the address number will be different
when accessing words or Dwords in the Gateway data
tags than the PLC. Table 6 shows the address relation-

ship for integer tags mapped as word in the Gateway.

Here, the word or Dword addresses follow the nor-
mal numeric increment and are not directly related
to the word or bytes they are composed of.

FiG. 68. Gateway Addressing Scheme

Table 6: Addressing Relationship

PLC Gateway
Block Type Input (bytes) | Output (bytes) | Input (words) |Output (words)
64 words in, 64 words out 256...383 256...383 0...63 0...63
16 words in 384...415 - 64...79 -
5 words out - 384...393 - 64...68

312785D
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Useful Formulas

The following formula can be used to find the byte num-
ber from a word address:

ByteAddress = PLCOffset + (WordAddress x 2), where:

» ByteAddress is the address we are looking for in the
PLC

* PLCOffset is the first byte number in the complete
block mapping in the PLC, here 256

* WordAddress is the address mapped in the Gate-
way. So, for example, word 77 in the Gateway,
would start at byte 410 in the PLC, and so would be
composed of byte 410 and 411.

The following formula can be used to find the byte num-
ber from a Dword address:

ByteAddress = PLCOffset + (DWordAddress x 4),
where:

* ByteAddress is the address we are looking for in the
PLC

» PLCOffset is the first byte number in the complete
block mapping in the PLC, here 256

» DwordAddress is the address mapped in the Gate-
way. So, for example, Dword 14 in the Gateway,
would start at byte 312 in the PLC, and so would be
composed of byte 312, 313, 314 and 315.

NOTE: For the formula to work, all the blocks in the PLC

Profibus configuration for the Gateway have to be con-
secutive. FIG. 58.
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Appendix C: Graco Gateway to ControlLogix via Ethernet IP

Appendix C: Graco Gateway to ControlLogix via

Ethernet IP

Overview

This appendix describes the configuration steps neces-
sary to establish a communication path between the
Graco Gateway and a ControlLogix unit. You will need
either a 1756-ENET/B or a 1756-ENBT/A together with
a Logix5550 controller. It may be possible to upgrade a
1756-ENET/A to the required 1756-ENET/B by flashing
the firmware; you should check the hardware version
with your vendor before hand to ensure its suitability.
You will also need Rockwell Software’s RSLinx and
RSLogix 5000 software configuration utilities.

Introduction

In the following example, the ControlLogix will establish
a Classl connection and I/O data will be exchanged
between the ControlLogix and the Graco Gateway ter-
minal. The network parameters used in this example will
almost certainly not apply to your application. Be sure to
consult your network administrator when selecting
appropriate values.

il
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Ethernet Connection
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Fic. 69: Ethernet PLC Connection
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Appendix C: Graco Gateway to ControlLogix via Ethernet IP

ControlLogix Configuration

1. Runthe RSLogix 5000 program and create a new

configuration.

Add a 1756-ENET/B or a 1756-ENBT/A to your 1/O
configuration. You will need to:

a. Switch to offline mode.

b. Right click on the 1/O Configuration node in the
Controller Organizer view and choose Add
Module.

c. Inthe Select Module Type window, choose
1756-ENET/B or 1756-ENBT/A entry. RSLogix
will open the Module Properties window. See
FiG. 70.

d. Enter the IP Address of the ENET/B or ENBT/A
interface.

e. Click Finish to add the interface to your 1/O con-
figuration.

f.  Download the configuration.

g. Switch to online mode and open the

1756-ENET/B or 1756-ENBT/A node properties
under the I/O Configuration in the Controller
Organizer.

Module Froperties - Local {(1756-EHET/B 2.1)

Select the Port Configuration Tab from the Mod-
ule Properties window. See FIG. 71.

i. Enter the IP Address and Subnet Mask. The IP
Address must match the IP Address entered in
the Properties window (FIG. 70).

j-  Apply the settings using the Set button.
You can now verify the network module network
communications with your unit using suitable

diagnostic tools such as Ping.

Add the Graco Gateway to the RSLogix configura-
tion as follows:

a. Switch to offline mode.

b. Right click on the 1756-ENET/B or
1756-ENBT/A node under the 1/0O Configuration
in the Controller Organizer view and choose
Add Module.

c. Inthe Select Module Type window, choose
Generic Ethernet Module. See FIG. 72.

d. Click OK. This will open the Module Properties

window. See FIG. 73.
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Slok 2 H
Fesisior: i_. 1 ilj Electrane fewng | Compelioks Modubs j

Canrel L Frise | Hen

Fic. 70. Ethernet Module Properties
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M (odule |"‘l1:-|ZIi:-Fti'.’:5 Local:2 (1 F56-EHEL/B £.1)
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FiG. 71. Port Configuration Window
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Appendix C: Graco Gateway to ControlLogix via Ethernet IP

In the Name field, enter a descriptive hame to
identify the module. See FIG. 73.

In the Address/Host Name field, enter the IP
Address of the Graco Gateway.

Enter 2 in the Input Assembly Connection Point
and a size of 2. This will match a read only
Slave Gateway block configured in the Gate-
way, and will be used for reading data from the
Gateway to the ControlLogix.

Enter 3 in the Output Assembly Connection
Point and a size of 2. This will match a
read/write Slave Gateway block configured in
the Gateway, and will be used for writing data
from the ControlLogix to the Gateway.

Module Properties - EIP (ETHERHET-MODULE 1.1)

i. Enter 1 inthe Configuration Connection Point
and a size of 0. Configuration data is not sup-
ported by the Gateway.

j-  Press Finish to add the Gateway to the 1/O con-

figuration.

The connection points and sizes are arbitrary, as
long as the connection point, size, and direction are
matched in the configuration of the Gateway.

Connection point direction is always relative to the
originator, which in the case of the current Gateway
Ethernet/IP implementation is always the device
and never the Gateway. An input connection there-
fore specifies data flow from the Gateway to the
device, and an output connection specifies data flow

from the device to the Gateway.

Addiess / Host Mamne
" |P Addices: | SR = I T Ti |

£ Hoat Mame: |

Cancel

Type: ETHERMET-MODULE Genee Ethemet Madiie
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Ouipat |2 2 = 3k
i Feernzk: | Data - DINT 7 :
aonen Fermak D ata E3| Configurafiort |1 0 = ok

|
—

Mext + | Help

Fic. 73. Ethernet Module Properties

76

312785D



Appendix C: Graco Gateway to ControlLogix via Ethernet IP

See FIG. 74. You should now see a new ETHER- 4. Download the new I/O configuration to the control-
NET-MODULE Gateway_ HMI branch of the ler. Once the download is complete, the controller
1756-ENET/B node in the I/O Configuration view. will automatically establish a new Class1 connection
You should also see three new entries in the Con- with the Gateway.

troller Tags view:

FiG. 74.

Gateway_HMI:| to view the input data
Gateway_HMI:O to modify the output data
Gateway_HMI:C to view the configuration data
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Appendix C: Graco Gateway to ControlLogix via Ethernet IP

Graco Gateway Configuration

1. Ethernet Settings. Set the IP Address to

192.168.2.101. This should match the Address/Host
Name entered in FIG. 73.

Protocol Settings. Select the Ethernet/IP Slave
Adapter communications driver.

The ENET/B module prefixes all output data with a
header containing status information about the origi-
nator’s run/idle state. With the Run/Idle Header
checked, the communications driver will automati-
cally process the header, and data will be ignored if
the device is in the Idle state. With the option
unchecked, extra space must be allocated in the
Gateway block to receive the status information; all
data is accepted regardless of the device state.

Device Settings. A Gateway block must be created
for each connection point.

For the purpose of configuring, the data transfer
terms input and output are relative to the device and
not the Gateway. An input connection is therefore
specified as Gateway to Device, and an output con-
nection is specified as Device to Gateway.

Connection point mapping is defined in the Start

Address block setting and comprises the connection
point instance and a data offset. The instance must
match that specified by the originator; the offset can
be used to skip over data not required by the Gate-

way, useful mainly on shared connection points.
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Fic. 75. Ethernet Block Settings
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The following settings mirror the I/O settings of the
ControlLogix configuration detailed earlier.

a. Input Connection Point. Create a Gateway
block configuration (see Table 7).

Table 7: Input Connection Points

Connection Point 2

Data Offset 0000

Data Type Long as Long

Block Size 2

Direction Graco Gateway to Device

b. Output Connection Point. Create a Gateway
block configuration (see Table 8).

Table 8: Output Connection Points

Connection Point 3

Data Offset 0000

Data Type Long as Long

Block Size 2

Direction Device to Graco Gateway

312785D

Appendix C: Graco Gateway to ControlLogix via Ethernet IP

Data Mapping. the connection points are how con-
figured so that:

Gateway HMI:O >> PLC1:Blockl

Gateway_HMI:l << PLC1:Block2

Testing. Using the RSLogix5000 program, you can
modify tags Gateway HMI:O and verify they are
written into Varl and Var2, and verify changes
made in the Gateway to tags Var3 and Var4 are
updated in Gateway_ HMI:I. Ensure the device is in
the Run mode, otherwise the data transfer will be
ignored by the Gateway.
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Dimensions

Dimensions
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Technical Data

Electrical power . . ... ... . . i

Communication ports
USB/PG POItS . ...

Serial Ports . ........ .. ...

RS232/PGPort . ........ .
COMMPOTItS ..o o
DH485 TXENPort . ........ ... ... .. ....

EthernetPort . .......... ... .. . ... . ... ...

Memory
On-boardusermemory ...................
On-board SDRAM . ........ ... ... ...
Memorycard ........... ... .. ...

Real-timeclock. .. ......... .. ... . . . ..

Environmental conditions
Operating temperaturerange. . . ............
Storage temperaturerange . ...............
Operating and storage humidity. . . ..........
Vibration accordingto IEC 68-2-6 ...........
Shock according to IEC 68-2-27 .. ..........
Altitude. .. ...

Construction . .. ...

Powerconnection. .. .......... ... ...
Mounting. . ...

Weight (Gateway control boxonly) .............
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Technical Data

24 Vdc, +/- 10%. 200 mA minimum without expansion card; 1
Amp maximum with expansion card fitted. Requires Class 2 or
SELV rated power supply.

Adheres to USB specification 1.1. Device only using Type B
connection.

Format and Baud rates for each port are individually software
programmable up to 115,200 baud.

RS232 port via RJ12.

RS422/485 port via RJ45, and RS232 port via RJ12.
Transmit enable; open collector, Vou=15 Vdc, Vo =0.5V @ 25
MA maximum.

10 BASE-T/100 BASE-TX, RJ45 jack is wired as a NIC (Net-
work Interface Card).

STS: Status LED indicates condition of Gateway module.
TX/RX: Transmit/Receive LEDs show serial activity.
Ethernet: Link and activity LEDs.

CF: CompactFlash LED indicates card status and read/write
activity.

4 Mbytes of non-volatile Flash memory.

2 Mbytes

CompactFlash Type Il slot for Type | and Type Il cards. Used
for optional database storage only.

Typical accuracy is less than 1 minute per month drift. Lithium
coin cell battery; typical lifetime of 10 years at 25°C. This unit is
not field serviceable. All work must be done by a qualified tech-
nician.

0 to 50°C

-30 to +70°C

80% relative humidity, non-condensing, from 0 to 50°C
Operational 5 to 150 Hz, in X, Y, Z direction for 1.5 hr, 2 g’'s
Operational 30 g, 11 msec in 3 directions

Up to 2000 m

Carbon steel and stainless steel. Installation category 1, Pollu-
tion degree 2.

Removable wire clamp screw terminal block. Wire gage capac-
ity: 24 AWG to 12 AWG. Torque: 4.45-5.34 in-Ib (0.5-0.6 Nem).
Snaps onto standard DIN style top hat (T) profile mounting rails
according to EN50022 -35 x 7.5 and -35 x 1.5.

15.1 oz (456.4 g)
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Graco Standard Warranty

Graco warrants all equipment referenced in this document which is manufactured by Graco and bearing its name to be free from defects in
material and workmanship on the date of sale to the original purchaser for use. With the exception of any special, extended, or limited warranty
published by Graco, Graco will, for a period of twelve months from the date of sale, repair or replace any part of the equipment determined by
Graco to be defective. This warranty applies only when the equipment is installed, operated and maintained in accordance with Graco’s written
recommendations.

This warranty does not cover, and Graco shall not be liable for general wear and tear, or any malfunction, damage or wear caused by faulty
installation, misapplication, abrasion, corrosion, inadequate or improper maintenance, negligence, accident, tampering, or substitution of
non-Graco component parts. Nor shall Graco be liable for malfunction, damage or wear caused by the incompatibility of Graco equipment with
structures, accessories, equipment or materials not supplied by Graco, or the improper design, manufacture, installation, operation or
maintenance of structures, accessories, equipment or materials not supplied by Graco.

This warranty is conditioned upon the prepaid return of the equipment claimed to be defective to an authorized Graco distributor for verification of
the claimed defect. If the claimed defect is verified, Graco will repair or replace free of charge any defective parts. The equipment will be returned
to the original purchaser transportation prepaid. If inspection of the equipment does not disclose any defect in material or workmanship, repairs
will be made at a reasonable charge, which charges may include the costs of parts, labor, and transportation.

THIS WARRANTY IS EXCLUSIVE, AND IS IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO WARRANTY OF MERCHANTABILITY OR WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE.

Graco’s sole obligation and buyer’s sole remedy for any breach of warranty shall be as set forth above. The buyer agrees that no other remedy
(including, but not limited to, incidental or consequential damages for lost profits, lost sales, injury to person or property, or any other incidental or
consequential loss) shall be available. Any action for breach of warranty must be brought within two (2) years of the date of sale.

GRACO MAKES NO WARRANTY, AND DISCLAIMS ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE, IN CONNECTION WITH ACCESSORIES, EQUIPMENT, MATERIALS OR COMPONENTS SOLD BUT NOT
MANUFACTURED BY GRACO. These items sold, but not manufactured by Graco (such as electric motors, switches, hose, etc.), are subject to
the warranty, if any, of their manufacturer. Graco will provide purchaser with reasonable assistance in making any claim for breach of these
warranties.

In no event will Graco be liable for indirect, incidental, special or consequential damages resulting from Graco supplying equipment hereunder, or
the furnishing, performance, or use of any products or other goods sold hereto, whether due to a breach of contract, breach of warranty, the
negligence of Graco, or otherwise.

FOR GRACO CANADA CUSTOMERS

The Parties acknowledge that they have required that the present document, as well as all documents, notices and legal proceedings entered into,
given or instituted pursuant hereto or relating directly or indirectly hereto, be drawn up in English. Les parties reconnaissent avoir convenu que la
rédaction du présente document sera en Anglais, ainsi que tous documents, avis et procédures judiciaires exécutés, donnés ou intentés, a la suite
de ou en rapport, directement ou indirectement, avec les procédures concernées.

Graco Information

For the latest information about Graco products, visit www.graco.com.

TO PLACE AN ORDER, contact your Graco distributor or call to identify the nearest distributor.
Phone: 612-623-6921 or Toll Free: 1-800-328-0211 Fax: 612-378-3505

All written and visual data contained in this document reflects the latest product information available at the time of publication.
Graco reserves the right to make changes at any time without notice.

Original instructions. This manual contains English. MM 312785

Graco Headquarters: Minneapolis
International Offices: Belgium, China, Japan, Korea

GRACO INC. AND SUBSIDIARIES « P.O. BOX 1441 « MINNEAPOLIS, MN 55440-1441 « USA
Copyright 2009, Graco Inc. All Graco manufacturing locations are registered to 1ISO 9001.
Www.graco.com
Revision D, May 2016
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